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본문서는 SCIEX 장비를구매한고객들이 SCIEX 장비를작동하는데이용할수있도록제공됩니다. 본문
서는저작권보호를받으며본문서또는본문서의어느일부에대한복제도엄격히금지됩니다. 단, SCIEX
가서면으로허가한경우는제외됩니다.

이문서에서설명될수있는소프트웨어는사용권하에제공됩니다. 사용권에서특별히허용된경우를
제외하고어떠한수단으로든소프트웨어를복사, 수정또는배포하는것은법률위반입니다. 또한, 사용
권은소프트웨어를어떠한목적으로든디스어셈블하거나리버스엔지니어링하거나디컴파일하는것을
금할수있습니다. 제품보증은그안에명시되어있습니다.

이문서의일부는다른제조업체및/또는제조업체의제품의참조자료가될수있으며, 여기에는각소유
자의상표에따라상표및/또는기능으로등록된부품의이름이포함될수있습니다. 이러한이용의목적
은 SCIEX가장비에포함시키기위해공급하는해당제조업체제품을지명하는것에만국한되며, 이는타
인이이러한제조업체및/또는제조업체의제품이름을상표로이용할수있는권한및/또는허가를의미
하거나타인이이러한이름을상표로이용하도록허용하지않습니다.

SCIEX 보증은제품판매또는허가시점에제공되는명시적보증에만국한되며 SCIEX의독자적및독점적
진술, 보증및의무입니다. SCIEX는법령이나그외의법률또는거래과정이나거래의관습으로인한발
생여부와관계없이상품성보증또는특정목적에대한적합성보증을포함하나이에국한되지않는명
시적혹은암묵적보증등기타어떤종류의보증도제공하지않습니다. 이와같은모든보증은명확히부
인되며직간접적손해를포함해구매자가여기에설명된장비를사용할수있는모든용도또는이로인
해발생한모든불리한상황에대해어떠한책임또는불확정책임도지지않습니다.

연구전용.진단절차에사용하지마십시오.

AB Sciex는 SCIEX로사업을운영하고있습니다.

여기에서언급된상표는 AB Sciex Pte. Ltd. 또는각소유주의재산입니다.

AB SCIEX™는사용허가를받아사용되고있습니다.

© 2018년 AB Sciex

AB Sciex Pte. Ltd.
Blk 33, #04-06
Marsiling Ind Estate Road 3
Woodlands Central Indus. Estate.
SINGAPORE 739256
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이문서는일부도구및소프트웨어에서사용가능한기능에대한사용지침프로그램개요를제
공합니다. 사용가능한모든작동에대한세부설명을제공하지는않지만소프트웨어가해결할
수있는보다일반적인작업흐름의일부를설명합니다.

구성
일부기능및작업은특정어플리케이션및작업에적합하지만대부분은일반적이며정성적데
이터를분석할때자주사용됩니다. 이섹션의문서는소프트웨어개념에대한간략한소개및
가장일반적인일부및필수적인작업에대한설명을제공합니다. 시퀀스섹션은특정작업흐름
에대한접근법을설명하며, 소프트웨어와공급된샘플데이터파일을사용합니다.

샘플파일은 SCIEX OS폴더의 SCIEX OS DVD로분배됩니다. 전체프로젝트가컴퓨터의 D:\SCIEX OS
DATA 폴더로복사됩니다. 다음샘플파일들은본자습서의예시에서사용됩니다.

• Bromocrip_IDA-DBS alone_T=1.wiff

• Bromocrip_IDA-DBS in plasma_T=0.wiff

• Bromocrip_IDA-DBS in plasma_T=1.wiff

• DataSET61.wiff

• DataSET62.wiff

• DataSET63.wiff

• DataSET64.wiff

• DataSET65.wiff

• DataSET66.wiff

• RP_digests. wiff

• RP_Intact.wiff

• Bromocriptine.mol

브로모크립틴파일은쥐간마이크로솜을통한네거티브모드 IDA 잠복기분석에서비롯되었습
니다. Bromocrip_IDA-DBS alone_T=1.wiff는한시간지점에서확보되었지만나머지두개는혈장에
투여된 0 및한시간지점에적합했습니다. Bromocriptine.mol 파일에는브로모크립틴에적합한분
자구조가포함되어있습니다. DataSET61 ~ DataSET66 파일은로라타딘및그불순물을수집함으
로써만들어졌습니다. 다른데이터세트는다른농도레벨을나타냅니다. RP_Intact.wiff 파일은온
전한미오글로빈을분석함으로써만들어졌습니다. RP_digests.wiff 파일은트립신을통해소화되
는미오글로빈을분석함으로써만들어졌습니다.
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옵션
소프트웨어는명령에따라수행할수있는방법을미세조정하는많은옵션을제공합니다. 그림
1-1에서볼수있는것과같이일부소프트웨어는 Shift키를누르고있는경우에만대화상자를
표시할수있는체크박스를제공합니다. 이를통해매개변수를변경할필요가없는경우대화
상자와상호작용할필요를없애줍니다. 이런명령메뉴에는위쪽을가리키는화살표가포함되
어있습니다.

그림 1-1 옵션

창
소프트웨어는정보노출및수신에창(window)을사용하지만기본사용자인터페이스구성요소
는창(pane)입니다. 창(window)은하나이상의창(pane)을포함할수있지만창(pane)은한번에하
나만활성화할수있습니다. 창은메뉴및도구모음에서명령을수신합니다. 메뉴및도구모음
은이들이포함하고있는창및데이터를이용할수있는방법을제공합니다.

창은스펙트럼및크로마토그램, 히트맵또는표뿐만아니라보다특별한화면등의그래프를포
함할수있습니다. 일반처리작업에있어정보를보여주기위해창을생성하거나창내에표시
된데이터에작업을합니다. 모든창은일반적인단일및두개창도구를포함합니다. 대부분의
창은창의유형에따라지정된추가도구가있습니다. 추가도구는보다일반적인명령에액세스
를제공합니다.

일반적인창의사례는그림 1-2에서확인할수있습니다. window에는두개의활성 pane, 크로마
토그램및색채를입힌테두리와도구모음이있습니다.
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그림 1-2 Panes Within a Window에대한사례

일반적인창작업은일반창도구모음및두개창도구모음에요약되어있습니다. 창별작업은
그래프에요약되어있습니다.

일반창도구모음

일반단일창작업을사용하려면아이콘을클릭합니다.

표 1-1 일반창도구모음아이콘

이름(툴팁)아이콘

이창삭제

활성창을확장해창을채움

이창숨김

다른모든창숨김
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표 1-1 일반창도구모음아이콘 (계속)

이름(툴팁)아이콘

현재숨겨진모든창표시

다른모든창삭제(해당창다음의창만삭제하려면 Ctrl 키를누른상태에서수행)

참고: 메뉴바바로아래에위치한마스터도구모음에서유사한아이콘또한사용할수있습니
다. 마스터도구모음에있는아이콘들중하나를클릭하는것은활성창에있는아이콘을클릭
하는것과동일한효과가있습니다. 이도구모음은활성창크기를조정한후아이콘중일부가
보이지않을때유용하게사용할수있습니다.

이창삭제

창이여러개열려있는경우이아이콘을사용하여해당창을삭제합니다. 창이하나만열려있
을때는아이콘을사용할수없습니다.

활성창을확장해창을채움

이아이콘을사용해전체창을채우기위해창을확장하거나기존크기창으로되돌아갑니다. 창
에여러내부창이있는경우이아이콘은일시적으로내부창하나에초점을맞춥니다.

각창의경우창의상단에별도탭이표시됩니다. 적절한탭을클릭해창간에전환합니다.

참고: 창의제목이긴경우모든탭이보이지않을수있습니다. 탭의오른쪽의화살표버튼을
사용해스크롤합니다. 모든창을표시하는기존화면으로돌아가려면아이콘을다시클릭합니
다.

그림 1-3 확장된창에대한사례

자습서Explorer
RUO-IDV-05-2906-KO-B8 / 113

소개



이창숨김

이아이콘을사용해창(window) 내의나머지창(pane)들이사용가능한공간을채울수있도록해
당창(pane)을숨깁니다. 이아이콘은창의하위세트를보기만하고다른창을영구적으로삭제
하고싶지않을때유용합니다.

다른모든창숨김

해당창을제외한모든창을숨기려면이아이콘을사용합니다. 결과는활성창을확장해창을
채움아이콘을클릭했을때와유사합니다. 그이유는두경우모두해당창을유지한상태에서
공간만을채우기때문입니다또다른창이이후에생성되는경우차이점은명백합니다. 확장된
창의경우에새로운창이활성화되어사용가능한공간을채웁니다. 숨겨진창의경우에두개의
창(기존활성창및새로운창)을모두볼수있습니다.

현재숨겨진모든창표시

이아이콘을사용해숨겨진모든창을표시합니다.

다른모든창삭제

Ctrl 키를누르지않은경우이아이콘은해당창을제외한모든창을삭제합니다. 이옵션은샘플
을정리및재처리하는데유용합니다. 현재숨겨진어떠한창도삭제됩니다.

Ctrl 키를누른경우는해당창다음에있는창만삭제됩니다. 이옵션은창이여러개열려있는
경우초기에연창몇개만필요할때유용합니다. 이경우에숨겨진창은삭제되지않습니다.

두개창도구모음

아이콘을드래그하여두개창작업을합니다(사용가능여부는창유형에의해좌우됨). 소스창
은선택한아이콘이포함된창이고대상창은두번째창입니다.

표 1-2 두개창도구모음아이콘

이름(툴팁)아이콘

드래그및드롭으로창을재배열합니다.

또다른그래프에드래그하여활성데이터를그래프의활성데이터에추가합니다
(다른그래프의모든데이터세트에활성데이터를추가하려면 Ctrl 키를누른상태
에서수행).
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표 1-2 두개창도구모음아이콘 (계속)

이름(툴팁)아이콘

또다른그래프에드래그하여목표그래프의활성데이터에서활성데이터를뺍니
다 (목표그래프의모든데이터세트에서활성데이터를빼려면 Ctrl 키를누른상태
에서수행하고 Shift 키를길게눌러음의값을유지.)

또다른그래프에드래그하여목표그래프에있는활성데이터에겹치도록합니다
(활성데이터하나가아닌모든데이터세트에겹치도록하려면 Ctrl 키를누른상태
에서수행).

드래그및드롭으로창을재배열

이아이콘은각창의상단오른쪽모서리에서볼수있으며관련된창의위치를변경하는데사용
됩니다. 내부창하나의아이콘을클릭하여두번째내부창의상단, 하단, 왼쪽또는오른쪽부분
으로끌어갑니다. 마우스를놓는위치에따라첫번째내부창의위치가두번째내부창을기준으
로변경됩니다. 커서를끌때두번째내부창의한면이빨간색으로강조표시되어첫번째내부
창이표시된위치를나타냅니다. 그림 1-4는상단창의아이콘을하단창의오른쪽부분으로드
래그했을때의결과를보여줍니다.

그림 1-4 상단창의아이콘을하단창의오른쪽부분으로드래그했을때의결과

참고: 내부창은한창에서다른창으로드래그할수있습니다.

다른그래프에드래그하여다른그래프의활성데이터에활성데이터를추가

이아이콘을사용해두개의데이터세트를하나씩합산합니다. 소스데이터(원래클릭했던창에
서얻음)가목표데이터(아이콘에서손을뗄때위의창)에추가되었습니다. 수정데이터의제목
이업데이트되어수정되었다는것을표시합니다.

참고: 유형이동일한두데이터세트만하나로결합할수있습니다. 예를들어스펙트럼은크
로마토그램에추가할수없습니다.
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참고: 목표그래프에하나이상의중첩된추적이포함되어있는경우소스데이터는기본적으
로활성목표데이터에만추가됩니다. Ctrl 키를누른경우소스데이터는목표내모든데이터
세트에추가됩니다.

다른그래프에드래그하여목표의활성데이터에서활성데이터를빼기

이아이콘을사용해목표데이터에서소스데이터를뺍니다. 이아이콘은배경에서질량스펙트
럼을빼는경우에가장유용합니다.

참고: 목표그래프에하나이상의중첩된추적이포함된경우소스데이터는자동으로활성목
표데이터에서만차감됩니다. Ctrl 키를누른경우소스는목표내모든데이터세트에서차감됩
니다.

팁! 일반적으로소스의강도가목표보다큰경우의모든데이터포인트는기록되지않습니다.
이는음의 y값이폐기된다는것을의미합니다. Shift 키를누른경우음의강도를가진포인트가
기록됩니다.

목표그래프에서활성데이터에겹치도록또다른그래프에드래그하기

이아이콘을사용하여목표그래프에서소스그래프내활성데이터를겹치도록합니다. 작업을
완료한후목표그래프에는목표데이터의사본이들어있는새로운시리즈가포함되어있습니
다.

참고: 소스그래프에하나이상의중첩된추적이포함된경우자동으로활성데이터사본만목
표그래프로이동합니다. Ctrl 키를누르고있는경우소스그래프내의모든데이터세트사본
이목표그래프에겹쳐집니다.

그래프
그래프는데이터시각화및상호작용을가능하게하는창입니다. 여러작업은모든그래프에일
반적이지만다른작업은나타나는데이터유형에좌우됩니다.
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그림 1-5 그래프

일반명령은다음과같이요약됩니다.

• 커서를그래프의 x축또는 y축영역에드래그함으로써확대/축소및스크롤을수행할수있습
니다. 더블클릭하여축을기존범위로재설정하고 Shift키를누르면서축을클릭하면그래
프가이전화면으로전환합니다(확대/축소및스크롤의경우취소)

• 드래그하여임계값표시기를배치할수있습니다. 임계값은일반적으로어떤피크에라벨이
붙는지결정하고어떤피크가처리되는지결정하는데사용됩니다.

• 데이터영역에서드래그함으로써선택할수있습니다. 선택영역을통해데이터의일부가사
용되거나처리되도록정의합니다. 드래그하면서 Shift키를눌러여러영역을선택합니다.
Ctrl키를눌러 x 및 y축모두에서선택합니다.

그래프별도구모음

표 1-3 그래프별도구모음아이콘

이름(툴팁)아이콘

확대/축소된그래프가홈화면으로되돌아감

확대/축소선택으로전체보기
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표 1-3 그래프별도구모음아이콘 (계속)

이름(툴팁)아이콘

'확대/축소' 그래프표시(현재확대/축소추적용). 그림 1-6내용을참조하십시오.

선택된피크에적합한화살표기호추가

백분율 y축을사용합니다.

모든중첩된추적에라벨링

피크채우기

창에서그래프의 x축을다른축(동일한단위가짐)에연결(Control 키를길게눌러현
재모든그래프에적용)

이전실험을사용하기위해데이터전환

다음실험을사용하기위해데이터전환

선택된실험을사용하기위해데이터전환

선택한스펙트럼표시

배경분리범위설정

참고: 창아이콘삭제로시작하는이도구모음내최종여섯개아이콘은일반창도구모음에
서설명합니다.

확대/축소된그래프가홈화면으로되돌아감

등고선도를확대/축소한경우이아이콘을사용해 x 및 y축이기본범위를표시하고사용가능한
모든데이터를볼수있는홈화면으로되돌아갑니다. x축을더블클릭하면그래프가홈화면으
로되돌아갑니다. y축을더블클릭하면이축만전체범위로되돌아갑니다.

확대/축소선택으로전체보기

이아이콘을사용해등고선도를확대/축소하여선택된영역이전체가용공간을채우도록합니
다. 이아이콘을선택하기전에등고선도내에드래그하여선택을합니다. 등고선도의 x축(또는
y축)에서직접드래그하여확대/축소할수도있습니다.

'확대/축소' 그래프표시(현재확대/축소추적용)

이아이콘을사용해그림 1-6에서표시된것과같이기본그래프아래에서작은그래프사본을
표시합니다. 이개요그래프는사용가능한전체범위를항상나타내며분홍색선택부분을통해
기본그래프확대/축소영역을표시합니다. 기본그래프가확대/축소되면선택영역도이에따라
업데이트됩니다.
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피크선택부분을새위치로드래그하면서필요에따라기본그래프를스크롤합니다. 선택부분
의왼쪽또는오른쪽가장자리부근을드래그하여폭을조정합니다. 이때주그래프를필요에
따라확대/축소합니다.

필요한세부사항을보기위해꽤멀리확대/축소해야할때가종종있기때문에이기능은고분
해능질량스펙트럼에유용합니다. 개요그래프는확대/축소된영역을전체질량범위와관련해
추적하는데에도사용할수있습니다.

그림 1-6 개요그래프표시

선택된피크에적합한화살표기호추가

이아이콘을사용해지금선택한그래프영역내에서가장큰피크에화살표를추가합니다. 그림
1-7은보여지는바와같이 829 피크(대략)를선택한경우이아이콘을클릭하는결과를보여줍니
다.

그림 1-7 단일화살표기호추가

화살표는데이터에서참조점의역할을합니다. 화살표와인접하지않은피크는가장가까운화
살표에서의거리로자동으로레이블이붙습니다. 가장큰 x값을가진화살표인근피크는실제 x
값으로레이블이붙습니다. 마지막이아닌화살표인근의피크는보다높은 x값을가진화살표
에관련하여라벨이붙습니다. 그림 1-7에서약 829 Da에서피크는실제m/z값으로라벨이붙고
동위원소피크는이피크에서의거리로라벨이붙습니다. 화살표왼쪽피크(보이지않음)는음
라벨값을가지게됩니다.

화살표는대부분스펙트럼을통해사용되며 MS/MS 스펙트럼등에서동위원소, 중성손실등질
량차이기대치를찾기위한편리한방법을제공합니다. 그림 1-8은화살표가아미노산잔기중
성손실과일치하는값에추가되었던 MS/MS 펩타이드스펙트럼을보여줍니다. 예를들어 99.02
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로라벨이붙은피크는 1050.73 Da 피크에서발린손실이있을수있고 114.03으로라벨이붙은다
음피크는아스파라긴등의추가손실이있을수있습니다. -113.08로라벨이붙은피크는 129.02
로라벨이붙은피크로부터류신또는이소류신손실이있을수있습니다(709 Da에가까운실제
m/z 속도갖춤).

그림 1-8 여러화살표기호추가

이상대피크라벨링이사용되지않으면의 Use Arrows for Relative Peak Labeling메뉴항목
을지웁니다.그림 1-9이경우특정관심피크를표시하는데화살표를사용합니다.

그림 1-9 Add Arrow Marker Menu

사용자는화살표를새위치로드래그할수있습니다. 화살표를등고선도안으로드래그하면드
래그동작이취소됩니다. 화살표를그래프외부로드래그하면화살표가삭제됩니다. 의메뉴에
서 Remove All Arrows를선택하여화살표를삭제할수도있습니다.그림 1-9

퍼센트 Y축사용

이아이콘은 y축스케일링을측정합니다. 선택된경우중첩된추적을측정해각추적에대한최
대값이 100%가되도록합니다. 중첩된추적의절대등급이매우다른경우퍼센트 y축을사용하
는것이편리합니다.

모든중첩된추적에라벨링

여러추적이중첩된경우활성추적에라벨이자동으로붙습니다. 이아이콘을클릭해모든추적
에라벨을붙입니다. 다시아이콘을클릭하여라벨을제거하고기존화면으로전환합니다.

피크채우기

이아이콘을클릭해어둡게채우거나밝게채우는것을교대로하여활성데이터의피크를채웁
니다. 이기능은피크의시작점과중지점을정확하게찾는데유용합니다. 다시아이콘을클릭하
여채우기를제거하고기존화면으로전환합니다.

창에서그래프의 x축을다른축(동일한단위가짐)에연결

한그래프에서축을확대/축소하는경우나머지축이동일한범위를표시하기위해자동조정될
수있도록두개이상의그래프축을연결할수있습니다. 이기능을사용하면이러한그래프에
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서데이터를비교할때유용할수있습니다. 동일한그래프에서데이터세트를중첩되도록하는
것이대안이됩니다. 하지만이것이반드시바라는결과는아닙니다.

연결할각그래프에서창에서그래프의 x축을다른축(동일한단위가짐)에연결아이콘을클릭
합니다. Ctrl키를누른상태에서이아이콘을클릭하면같은창에서 x축단위가동일한현재그
래프의모든 x축이활성그래프로연결됩니다. 예를들어스펙트럼이 3개가표시된경우이항목
중하나에서 Ctrl키와창에서그래프의 x축을다른축(동일한단위가짐)에연결아이콘을동시
에클릭하면스펙트럼 3개가모두하나로연결됩니다.

참고: 이사례에서새로운스펙트럼이이후에생성되는경우나머지스펙트럼에연결되지않
습니다. 새로생성된스펙트럼을연결하려면연결된그래프의 x축을다른축(동일한단위가
짐)에연결아이콘을클릭합니다.

그래프의 x축만자동으로연결됩니다. 이경우한그래프가수동으로확대/축소된경우나머지
그래프들은 y축을자동확대/축소하여화면내에서피크가가용공간을채울수있도록합니다.

연결된그래프를연결해제하려면적절한그래프에서그래프의 x축을다른축(동일한단위가
짐)에연결아이콘을클릭합니다. 이렇게작업을진행하는동안 Ctrl키를눌러동일한창에서동
일한 x축단위를가진모든그래프에대해연결해제를합니다.

다음실험을사용하기위해데이터전환

그래프의활성데이터가마지막이아닌특정실험과관련있는경우이아이콘은데이터를다음
실험이아닌동일한유형의데이터로교체합니다.

예를들어실험 2의 TIC가활성상태이면이아이콘을클릭해실험 3의 TIC로전환합니다. 주어진
시간에서의스펙트럼이실험 2에대해활성상태인경우이아이콘을클릭해실험 3에대해동일
한시간의스펙트럼으로전환합니다.

이전실험을사용하기위해데이터전환

그래프의활성데이터가첫번째실험을제외한특정실험과관련이있는경우이아이콘은데이
터를동일한유형의데이터로대체하지만이전실험의경우로제한합니다.

예를들어실험 3의 TIC가활성인경우이아이콘을클릭해실험 2의 TIC로전환합니다. 실험 3에
해당하는주어진시간에서의스펙트럼이활성인경우이아이콘을클릭해실험 2에해당하는동
일한시간의스펙트럼으로전환합니다.

선택된실험을사용하기위해데이터전환

이아이콘을사용하면실험을하나씩스크롤하지않고사용할특정실험을선택할수있습니다.
아이콘을클릭하면사용가능한모든실험이나열되는대화상자가열립니다. 활성샘플이강조
됩니다. 목록내실험을클릭해선택한후 OK를클릭합니다. 그림 1-10내용을참조하십시오.
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그림 1-10 Select Experiment 대화상자

선택한스펙트럼표시

이아이콘을사용해그래프에서현재선택한시간범위의평균질량스펙트럼을생성합니다. 선
택영역내에서더블클릭하여동일한결과를달성할수있습니다.

배경분리범위설정

이아이콘을사용해크로마토그램에서생성된스펙트럼용자동배경분리를수행합니다.

스펙트럼별도구모음

표 1-4 스펙트럼별도구모음아이콘

이름(툴팁)아이콘

선택할수있는 XIC 표시

참고: 확대/축소된그래프를홈화면아이콘으로돌려보내기로시작하는이도구모음의첫열
한개아이콘은그래프별도구모음에서설명합니다.

참고: 창아이콘삭제로시작하는이도구모음내최종여섯개아이콘은일반창도구모음에
서설명합니다.
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선택한 XIC 표시

이아이콘을사용해그래프에서현재선택한질량범위에걸쳐총합인이온추출크로마토그램
(XIC)을생성합니다.

오버레이
그래프는동일한축을공유하며중첩이라고불리는다른추적을포함할수있어쉽게비교가가
능하도록합니다. Drag to another graph to overlay the active data in the target graph를
드래그함으로써그래프를생성할수있고일부창생성명령을통해자동으로생산됩니다. 크로
마토그램및스펙트럼내용을참조하십시오.

그림 1-11에서그래프는선택된모든중첩된추적에라벨링아이콘이있는네개의스펙트럼을
포함합니다. 그래프의헤더영역은두개의스펙트럼및채색된원에대한제목을나타내며추적
컬러를표시합니다. 활성추적은볼드체로표시됩니다. 이추적은임계값데이터, 다듬기등의
모든처리작업에대한목표이며일반적으로라벨이붙은유일한작업입니다. 제목왼쪽의아이
콘을클릭함으로서아이콘이변경되며활성추적제목만표기되도록합니다. 이기능은중첩이
여러개일때유용합니다. 아이콘을다시클릭해프로세스를역순으로진행합니다. 많은추적이
있고커서가제목위로이동하는경우커서는양방향화살표로변경되며드래그하는경우스크
롤막대의기능을하여모든제목에액세스할수있도록합니다.

그림 1-11 선택된모든중첩된추적아이콘라벨링을갖춘네개의스펙트럼이포함된그래프

활성추적을전환하는여러방법이있습니다.

• 채색된원을제목옆에클릭
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• 제목자체클릭

• 추적에데이터지점클릭(추적자체가아님)

중첩된그래프에오른쪽버튼을클릭하면사용가능한명령이포함된콘텍스트메뉴가나타나
표시된추적을시각적으로편집할수있습니다. Remove Active Trace및 Remove All Traces
Except Active옵션이예상대로작동합니다.

파일열기
그림 1-12에서확인할수있는바와같이소프트웨어는다른유형의데이터파일을열수있으며
명령을통해단일또는여러샘플을열수있습니다.

그림 1-12 파일메뉴

한샘플파일열기
Open Sample옵션으로 Select Sample대화상자를엽니다. 그림 1-13내용을참조하십시오.

이대화상자를통해단일파일을선택할수있습니다. 결과화면은선택한명령에좌우되는데
single .scan 파일은스펙트럼또는총이온크로마토그램(TIC)을표시하고 multiple scan .wiff 파일은
TIC(하나이상의실험이있는경우모든실험의총합)를표시합니다.
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그림 1-13 Select Sample 대화상자

.wiff 파일의왼쪽에있는아이콘을클릭하면파일내모든샘플이나타나며이후필요한파일명
을선택합니다. 파일내하나의샘플만있는경우파일명을선택하고 OK를클릭합니다.

여러샘플파일열기
Open Multiple Samples및 Open Heat Map TICs from Wiff옵션으로 Select Samples대화
상자가열립니다. 그림 1-14내용을참조하십시오.

왼쪽패널은폴더를탐색하고파일을지정할수있는 Open대화상자에해당하며오른쪽패널
은OK를클릭하면열리는파일을표시합니다. 다음과같이샘플을왼쪽에서오른쪽으로전송할
수있습니다.

• wiff 파일을확장하고샘플을선택한후오른쪽방향의화살표를클릭합니다.

• wiff 파일을확장하고샘플을선택한후오른쪽패널로드래그합니다.

• wiff 파일을확장한후샘플을더블클릭합니다.

파일에여러샘플이포함된경우 wiff 파일을선택하고오른쪽방향화살표를클릭함으로써또는
.wiff 파일을선택한후오른쪽패널에드래그함으로써샘플모두를전송할수있습니다.

다음과같이샘플을오른쪽에서왼쪽으로전송할수있습니다.

• wiff 파일을확장하고샘플을선택한후왼쪽방향의화살표를클릭합니다.

• wiff 파일을확장하고샘플을선택한후왼쪽패널로드래그합니다.

• 샘플을더블클릭합니다.
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그림 1-14 샘플대화상자선택

크로마토그램및스펙트럼
총이온크로마토그램(TIC), 스펙트럼및이온추출크로마토그램(XIC)은데이터를탐색및검토하
는데가장널리이용되는데이터보기입니다. 소프트웨어는이런데이터화면간연결을제공해
사용자가빠르게스펙트럼및 XIC를생성하여스펙트럼내피크가하나이상의크로마토그래피
피크에서비롯되는지의여부를측정할수있도록합니다.

총이온크로마토그램(TIC)
이것은스캔또는멀티스캔 .wiff 파일이열린경우에표시되는기본화면입니다. 표시된 TIC는각
스펙트럼에서모든이온의강도를합산하고합계를머무름시간의함수그래프로나타냄으로써
생성된크로마토그램과일치합니다.

루프실험을통해샘플이확보된경우표시된 TIC는두실험의강도합계와일치하며이것을표
시하기위해 x축에서특별한화살표표시가그려집니다. 그림 1-15내용을참조하십시오. 화살표
표시를더블클릭하는경우각실험에대해증첩된개별 TIC를표시하는새로운창이나타납니다.
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그림 1-15 TIC

샘플에 IDA 데이터가포함된경우선택된전구체의질량및머무름시간을표시하는그래픽방식
인 IDA 탐색기또는기존 TIC를선택합니다. 기존 TIC 옵션을선택하면 IDA 조사및 IDA 종속합계
에대한별도의 TIC가표시됩니다.

Show > Total Ion Chromatogram (TIC)을클릭하여언제든지 TIC를표시함으로써어떠한실험
이든선택할수있는대화상자가열립니다. 기간 1 선택은모든실험에대한 TIC를표시하지만
나머지입력항목은개별 TIC에해당합니다. 하나이상선택하려면 Shift+또는 Ctrl+클릭을사
용합니다.

스펙트럼
파일에단일스펙트럼만포함된경우파일이열린시기를스펙트럼이보여줍니다.

스캔이여러개포함된데이터의경우는크로마토그램을선택하고크로마토그램안쪽을두번
클릭하거나선택한스펙트럼표시아이콘을클릭해크로마토그램에서스펙트럼을표시합니다.
새로운영역을보여주는스펙트럼을업데이트하려면크로마토그램에서선택직사각형을드래
그합니다.

첫번째선택을완료한후 Shift키를눌러여러영역을선택합니다. 중첩된스펙트럼이포함된
새로운스펙트럼창을생성하려면이런선택에서더블클릭하거나선택한스펙트럼표시아이
콘을클릭합니다.

IDA의경우안내를통해모든종속스펙트럼을중첩되게하거나첫번째스펙트럼오픈을보여줍
니다. 후자의경우나머지스펙트럼을나타내려면왼쪽및오른쪽화살표키를사용합니다.

참고: 이대화상자에는 shift 키를눌렀을때만창을표시하는체크박스가있습니다.

두가지방법으로배경이없는스펙트럼을생성합니다.

• 피크및배경영역에적합한별도의스펙트럼을생성한후배경스펙트럼에서배경이없는두
개창아이콘을피크스펙트럼으로드래그합니다.

자습서Explorer
RUO-IDV-05-2906-KO-B22 / 113

소개



• 크로마토그램에서하나또는두개를선택하고배경분리범위설정아이콘을클릭함으로써
함으로써배경영역을정의합니다. 배경영역이정의될때생성된모든스펙트럼은자동으로
배경분리됩니다. 배경영역은크로마토그램에서빨간선택직사각형으로표시되며표시된
데이터를변경하기위해이뿐아니라모든스펙트럼선택영역을이동시킬수있습니다. 배
경영역이정의된경우아이콘옆의화살표를클릭한후분리범위지우기를선택하여제거할
수있습니다.

참고: 피크라벨은화살표로표시된가장가까운피크와관련이있을수있기때문에화살표기
호는스펙트럼에서유용합니다. 여기에서손실또는부가물질량을측정하기위해신속한방법
을제공합니다. 여러중첩이있으며중첩된모든추적에라벨로표시하기아이콘을선택한경
우화살표와관련하여각중첩에라벨이붙습니다.

이온추출크로마토그램 (XIC)
XIC를두가지방법으로생성할수있습니다.

• Show > Extracted Ion Chromatogram (XIC)을클릭함으로써.

이작업진행시모드에따라시작및중단질량또는중앙및폭값을입력할수있는대화상
자가열립니다. 대화상자내에서오른쪽버튼을클릭하여콘텍스트메뉴에서이를변경할수
있습니다. 또한콘텍스트메뉴는기본폭설정및질량목록가져오기또는내보내기등의다
른유용한명령에대한액세스를제공합니다. 또한사용자는질량값이제거될때까지자동으
로사용될수있도록값을영속화할수있습니다.

• 스펙트럼에서하나이상의선택을한후여러개중하나에서더블클릭하거나 Displays an
XIC for selection아이콘을클릭함으로써.

이러한작업은각선택에해당하는 XIC를생성합니다. 프로그램은자동으로각선택범위에서
가장큰피크를측정하고 XIC를피크에적합한절반높이로우및높은질량값으로자동설정
합니다. Ctrl키를누른경우전체선택폭을사용할수있습니다.

두가지경우에서각선택에대해하나의중첩을포함하는그래프가표시됩니다. 선택부분이링
크로바뀝니다. 링크를드래그하여 XIC를업데이트합니다.

참고: XIC는일반적으로계산되며전체크로마토그래피범위에맞게표시되는데여러선택을
할수있으며고분해능기기로부터데이터를얻거나및많은스캔을포함하는경우프로세스가
느리게진행될수있습니다. XIC 범위를생성하는데사용되는스펙트럼의머무름시간에있어
이범위를작은창으로제한하는것이유용한기능입니다. 편집 > 옵션 > XIC탭을클릭한후에
나타나는대화상자의 XIC 탭에서이를설정할수있습니다.

등고선플롯및히트맵
LC/MS 등고선도(Show > LC/MS Contour Pane)는단일창의 LC/MS 샘플에서모든데이터를표
시합니다. 그림 1-16의사례는 TIC 및강도컬러코드화를나타내며이는코딩된강도색상으로
머무름시간대비m/z속도지도를보여줍니다. 이경우에색상제어또한표시되지만보기에서
오른쪽버튼을클릭하고 Show Appearance Controls옵션을지움으로써숨길수있습니다. 등
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고선도및크로마토그램이동일한 x축을가지고있기때문에비교용도로확대/축소및스크롤
이두화면에유사하게영향을미칠수있도록함께연결할수있습니다.

그림 1-16 TIC 및해당등고선지도

색상제어는min %및max %로정의된범위내강도를표시하기위해 256 색상팔레트를사용
합니다. min %이하의강도는 < min를사용해그려지며max %이상의강도는 > max를사용
해그려집니다. < min에사용된색상과데이터가동일하지않은경우(여기에서) min %이하의
어떠한데이터포인트도사라집니다. 이것은시각임계화의형식으로그림 1-17에서확인할수
있는것과같이등고선도를단순화할수있으며여기에서min %값이 0.5%로증가되었습니다.
색상제어에대한자세한정보는시스템사용자안내서를참조하십시오.
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그림 1-17 최소 % 값이 0.5% 증가된등고선지도

색상팔레트가보다작은강도범위를포괄할수있도록max %를줄임으로써저강도피크를강
조할수있지만이값보다큰모든피크는동일한색상을갖습니다. Log Scale체크박스를선택
함으로써이것또한강조할수있습니다. Log Scale을활성화하는데있어min %(예, 1 또는 0.1)
에대한 0이아닌값이필요하며이후색상을퍼센트강도의로그에표시합니다.

소프트웨어내멀티샘플시각화도구에는 TIC, XIC 및개별히트맵시리즈로서여러샘플에대한
스펙트럼을표시하는기능이포함되어있어샘플비교를지원할수있습니다. 그림 1-18은여섯
개의분석물질에서비롯된 TOF 크로마토그램시리즈용입니다. 여러샘플로작업내용을참조하
십시오.
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그림 1-18 히트맵크로마토그램
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이섹션은가장일반적인처리옵션중일부를설명합니다. 사용된파일은많은루프실험을거
친 IDA 파일이지만이사례에서는첫번째조사실험을사용하여간단한 LC/MS 분석을시뮬레이
션합니다. 다음섹션에서 IDA 기능에대해알아봅니다.

데이터파일열기

1. 메인도구모음에서 Open Sample아이콘을클릭합니다.

Select Sample대화상자가열립니다.

그림 2-1 Select Sample 대화상자

2. Sample Data폴더가아직선택되지않은경우 Browse를클릭하여 Sample Data폴더를탐
색합니다. 설치데이터파일위치에대한정보는구성을참조하십시오.

3. 파일내모든샘플을나타내려면 Bromocrip_IDA-DBS alone_T=1.wiff 파일의왼쪽에있는아이콘
을클릭합니다.

Bromocrip_IDA-DBS alone_T=1.wiff파일에하나의샘플만있습니다.

4. 샘플이름을선택한후 OK를클릭합니다.

이것은 IDA 파일이기때문에소프트웨어는선택된샘플을여는방법을지정할수있도록안
내합니다.

Explorer자습서
27 / 113RUO-IDV-05-2906-KO-B

2
크로마토그램및스펙트럼을통해
작업



그림 2-2 Open IDA Sample

5. As a standard TIC를클릭한후(선택되지않은경우) OK를클릭하여그림 2-3과같이 TIC를
생성합니다.

그림 2-3 TIC

이창에는조사스캔 TIC(파란색)에대해하나의중첩이있고종속(생성이온) 스캔총합에대
해또다른중첩이있습니다. 이경우에조사 TIC만나타내는조사데이터를처리하기원합니
다.
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하나의실험에적합한 TIC 표시

1. x축중앙에있는 Double-click to overlay individual TICs for all experiments아이콘을더
블클릭해모든실험에적합한중첩된 TIC를생성합니다.

새로운크로마토그램은활성창입니다. 조사는첫번째실험이기때문에활성추적은헤더의
볼드제목을통해표시됩니다.

그림 2-4 중첩된 TIC

2. 활성크로마토그램창내에서오른쪽버튼을클릭한후 Remove All Traces Except Active를
클릭해조사 TIC만남도록합니다.

그림 2-5 오른쪽버튼클릭메뉴
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3. 동일한창에서조사 TIC만남겨두려면다른모든창삭제아이콘을클릭합니다.

그림 2-6 조사 TIC

알고있는분자식에대한 XIC 나타내기
이데이터에서 4분에서 7분범위는작은피크몇개가확실하게보이지만많은피크가꽤강렬한
배경신호에의해모호해졌을수있습니다. 이샘플은브로모크립틴의마이크로솜잠복기에해
당하므로피크위치에대한초기안내서로예상되는분자이온의m/z속도를사용하십시오. 브
로모크롭틴의분자식은 C32H40N5O5Br이고이데이터가네거티브모드데이터이므로 (M – H)–이
온을볼수있을것으로예상됩니다.

1. Show > Mass Calculators를클릭합니다.

2. Mass Calculators창에서Mass Property탭을클릭합니다.

3. Formula필드에서분자식을입력합니다.

4. Charge state필드에서유형 -1을입력합니다.

5. 'H+' charge agent (else electron)를선택합니다.

6. Calculate를클릭합니다.
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참고: 분자식에서수동으로하나의전자를제거하고 'H+' 전하매개체(이외전자) 체크박스
를선택하지않는것또한가능합니다

다음과같은단일동위원소포함, 평균등많은질량값을보여주기위해대화상자가새로고
침됩니다.

그림 2-7 질량계산기창

참고: 이러한질량값으로동위원소가쉽게해결됩니다. 따라서동위원소포함 m/z 값이가
장적합한값입니다.

7. Monoisotopic m/z을선택한후 Ctrl+C를눌러값을클립보드에복사합니다.

8. Deletes this pane아이콘을클릭해Mass Calculators창을삭제하거나 Hides this pane아
이콘을클릭해창을숨깁니다.

9. Show > Extracted Ion Chromatogram (XIC)을클릭해 Specify XIC Ranges대화상자를
엽니다.
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그림 2-8 Specify XIC Ranges 대화상자

10. Specify XIC Ranges대화상자에서오른쪽버튼을클릭해콘텍스트메뉴를엽니다.

11.콘텍스트메뉴에서다음을행합니다.

a. Start/Stop Mode옵션이선택되지않았는지확인하여 XIC 값이중앙값및폭으로입력되
도록합니다.

b. Set Default Width를클릭한후, 0.05를입력하고 OK를클릭합니다.

c. Persist Ranges for Future Use를클릭하여다음대화상자사용시에값을기억하도록합
니다.
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그림 2-9 콘텍스트메뉴

12. Specify XIC Ranges대화상자로돌아갑니다.

각관심 XIC에대해하나의질량만입력하고기본폭이사용되도록지금대화상자를설정합
니다.

13. Center아래에있는첫번째셀을선택한후 Ctrl+V를눌러 7단계의질량값을붙여넣기합니
다.

14. OK를클릭합니다.

참고: 기본폭이설정되었기때문에개별값을입력할필요가없습니다.

창에는여러피크를보여주는브로모크립틴의예상분자이온에대한 TIC 및 XIC가포함되어
있습니다.
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그림 2-10 브로모크립틴의예상분자이온에대한 TIC 및 XIC

스텍트럼생성및상호작용

1. TIC 창을숨기고 XIC에서가장큰피크주위를선택한후 Displays a spectrum for selection
아이콘을클릭해이영역에적합한평균스펙트럼을생성합니다.
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그림 2-11 XIC 내가장큰피크에서발생한스펙트럼

참고: 그림 2-11에서, Options대화상자(Edit > Options에서사용가능)의 Peak Labeling &
Finding 탭에서 Label 필드는Mass (Charge)로설정되어있습니다.

2. x축을 630 Da에서 700 Da로드래그하여스펙트럼을이영역으로확대/축소합니다.

참고: 여기에는두가지단계가완료되어야합니다.

기대값인 652.2140과매우가까운 652.2199에피크가있고이는또한브롬동위원소유형을
표시하지만 668.2158에서시작하는두번째브롬동위원소집단이있습니다. 정확한m/z속
도값은 XIC에서선택된정확한머무름시간범위에따라다릅니다.

참고: 여기에서사용된라벨링양식은m/z속도및괄호내전하상태추정치를표시합니다
(피크간간격에따름). 동위원소가포함된것으로보이는피크는또한별표로표시됩니다.
라벨링알고리즘은 13C 외의동위원소를식별하지못하고 81Br 동위원소가단일전하를띄
게되지만동위원소를포함한다는것을올바르게표시하지않습니다.

3. Edit > Options를클릭하고 Peak Labeling & Finding탭을탐색하며 Label필드에서Mass
/ Charge로설정을변경함으로써라벨링양식을기본양식으로변경합니다.

4. OK를클릭합니다.

Explorer자습서
35 / 113RUO-IDV-05-2906-KO-B

크로마토그램및스펙트럼을통해작업



그림 2-12 다른라벨링양식을가진스펙트럼

5. 확장된스펙트럼에서 652.2199에서의피크주위를선택한후Adds arrow markers for selected
peaks아이콘을클릭합니다.

그림 2-13 선택된피크에서스펙트럼표시

질량라벨링은선택된피크와관련이있기때문에질량피크간차이가표시됩니다. 668.2158
에있는피크의라벨은산소의질량에해당되는 15.9959로표시되며, 이피크는히드록시브
로모크롭틴대사물질일가능성을시사합니다.

팁! 화살표를또다른피크로드래그함으로써이동시킬수있고화살표아이콘과인접한목
록에서 Remove All Arrows를선택함으로써제거할수있습니다.

6. 15.9959로피크라벨이표시된주위를선택한후선택용 XIC 표시아이콘을클릭합니다.

7. XIC Selection Ranges대화상자에서 OK를클릭합니다.
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그림 2-14 XIC 선택범위대화상자

그림 2-15 XIC

이것은 XIC를상호생성할수있는유용한방법입니다. XIC에사용되는폭은절반높이에서의
질량피크폭이며스펙트럼에서선택링크가자동으로표시됩니다.

8. 선택링크를드래그하여표시된 XIC를업데이트하고단계를반복함으로써추가합니다.

9. 새로운크로마토그램내 Drag to another graph to overlay the active data in the target
graph아이콘을클릭한후이들이중첩되도록크로마토그램을기존 XIC 창으로드래그합니
다.
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그림 2-16 중첩된 XIC

10.두번째크로마토그램창과스펙트럼을숨기거나삭제한후 4분에서 5분주위의영역이표시
되도록중첩된크로마토그램을확대합니다.

4.4분주위에는각 XIC에서하나씩생성된두개의피크가있으며, 가까이용리되었지만머무
름시간이똑같지는않습니다. 또한 668.216 크로마토그램에서많은피크가발생했으며이는
아마도다른히드록시대사물질의존재가있다는것을표시합니다.

11. 4.40분에서크로마토그램창을두번클릭해단일스캔에서발생한스펙트럼을생성합니다.
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그림 2-17 단일스캔에서발생한스펙트럼

XIC에서파선은이와같은스캔을표시합니다(그림 2-17에서화살표로표시). 선을드래그하
면 4.40분주위의영역을탐색할수있도록스펙트럼이업데이트됩니다. 한번에하나의스캔
을이동시키려면전방및후방화살표키를사용합니다. 668.215 이온에대한신호가 0(여기에
서배경이꽤높을수있음)인영역으로파선을이동함으로써 652.214 m/z속도의피크에대해
클린스펙트럼을달성할수있지만후자에해당하는클린스펙트럼은이방법으로달성할수
없습니다.

12.스펙트럼창을삭제합니다.

13.크로마토그램창에서 652 피크의왼쪽측면을포함하지만 668 피크를피해가는좁은영역을
선택한후배경분리범위설정아이콘을클릭합니다.

선택영역이분홍색으로변합니다.

분리범위가정의된경우이후생성된모든스펙트럼에서자동으로분리됩니다. 분리범위는
분리범위설정아이콘오른쪽의화살표를클릭한후목록에서분리범위지우기를선택하여
제거할수있습니다.

14.크로마토그램에서 668 피크의정점을포함하지만 652 피크는가능한조금포함하는또다른
영역을선택한후선택에대한스펙트럼표시아이콘을클릭합니다.
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그림 2-18 668 피크용배경분리된스펙트럼

결과는 668 피크에대한배경분리된스펙트럼으로 652 피크를거의포함하지않습니다. 비록
배경이보이지않지만크로마토그램에서두개의선택영역은각스펙트럼에연결되어있으
며크로마토그램의다른부분으로이동할수있습니다. 스펙트럼표시영역의이동을통해표
시된스펙트럼을업데이트할수있지만배경영역은변경되며이후생성된스펙트럼에만적
용됩니다.

15. Hides all other panes아이콘을클릭하고단일스펙트럼 TIC를클릭한후 Deletes all other
panes아이콘을클릭해 TIC만표시되도록합니다.

16. TIC 창이삭제된경우 Show > Total Ion Chromatogram (TIC)을클릭하고 Period 1,
Experiment 1을선택한후 OK를클릭합니다.

등고선플롯사용
데이터세트(크로마토그램또는스펙트럼)의일부를볼수있는대안으로등고선도를사용해실
험의전체개요를확보합니다. 등고선도는매우유용할수있지만최고의결과를얻기위해종종
시각매개변수를조절해야합니다. 이경우전구물질화합물은브롬과화합하며등고선도는브
롬동위원소유형을통해피크를찾는방법을제공합니다.
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1. 단일실험 TIC 활성을통해 Show > LC/MS Contour Pane을클릭한후결과등고선도도구
모음에서 Expands active pane to fill window아이콘을클릭하여유일창이보이도록합
니다.

2. 모양제어(하단왼쪽모서리의컬러상자)가보이지않는경우창에서오른쪽버튼을클릭하
고 Show Appearance Control을클릭합니다. 등고선플롯및히트맵및참조안내서를참조
하십시오.

그림 2-19 등고선도

팁! 실제피크를어둡게하는낮은수준의피크및잡음이지배하기때문에기본매개변수
를통한보기는매우유용하지않습니다. 다음을통해보다나은보기생성:

• 표시할최소강도를변경. 이를통해데이터를볼수없는지점과동일한색깔로표기된
이레벨이하의모든데이터포인트가변경됩니다.

• 컬러매핑을변경하여사용가능한컬러가작은피크의가시성을향상시키는보다좁은
강도범위를포괄하도록합니다.

3. min %값을 0.01로변경합니다. 이는기본피크의 0.01% 이하의강도를가진모든데이터포
인트가사라지게합니다.
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그림 2-20 등고선도

데이터에서훨씬더많은구조가표시됩니다. 공극부피및컬럼세척영역은알아보기쉽고
모든머무름시간에존재하고수직선으로표시되는수많은배경피크가있습니다.

4. Log scale체크박스를선택합니다.

낮은피크강도(예: 질량이 600에서 700 범위인 4분에서 4.5분주위의집단)를향상시키는효
과가있는강도로그에 (기본피크강도의백분율로) 선택한색상이매핑됩니다.

5. 이영역을선택한후 Zooms selection to full view를클릭합니다.

팁! 여느때와마찬가지로 x 및 y 축을독립적으로확대/축소할수도있습니다.
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그림 2-21 등고선도

화면은이영역에 79Br 및81Br 동위원소및 13C 동위원소와일치하는네개의평행선세트를통
해구별할수있는수많은브롬처리된피크가있다는것을보여줍니다.

6. 컬러컨트롤설정으로실험하고화면상의효과를관찰합니다.

7. 종료되면창을닫습니다.

데이터파일도닫습니다.

요약
이섹션에서는다음작업에대해논의했습니다.

• TIC를나타내는데이터파일검색및열기

• 화면을변경해하나의실험만사용되도록합니다.

• 질량계산기를사용해요소구조에서이온의질량을확인하고질량을사용해 XIC를생성합니
다.

• 스펙트럼및크로마토그램의양방향생성및스펙트럼상에서화살표기호사용으로피크간
질량차이를표시합니다.

• 스펙트럼이차감된배경생성
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• 등고선도를사용해데이터세트의개요를생성합니다.

이런작업은표시되는데이터유형에관계없이모든양방향데이터처리의기본입니다.
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IDA 실험에서하나이상의조사스펙트럼(MS3으로예상됨)이특정기준을충족하는경우 MS/MS
스펙트럼데이터가자동수집됩니다. 특정시간동안전구체질량(트리거로작용할수없도록함)
을배제함으로써동일한 LC 피크에서비롯된여러스펙트럼의수집을방지하기위해매개변수
를설정하는것은일반적입니다. 가끔씩불필요한스펙트럼이수집되는경우가있습니다. 이와
더불어피크가기준을충족하는대로 IDA 트리거가작동하기때문에일반적으로 LC 피크초기에
스펙트럼을생성하며최고의품질을제공하지않을수있습니다.

소프트웨어에는 IDA 데이터를표시하고필터링하며처리하는도구가포함되어있습니다. 이섹
션에서일부도구에대해알아봅니다.

시작전열린모든창을닫습니다.

스펙트럼표시및병합

1. 메인도구모음에서 Open Sample아이콘을클릭합니다.

Select Sample대화상자가열립니다.

2. Sample Data폴더가아직선택되지않은경우 Browse를클릭하여 Sample Data폴더를탐
색합니다.

3. Bromocrip_IDA-DBS alone_T=1.wiff파일을선택한후 OK를클릭합니다.

4. Open IDA Sample대화상자에서With the IDA Explorer를클릭한후 OK를클릭합니다.

프로그램은데이터파일내모든스펙트럼을검사한후다음그래프를생성합니다.
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그림 3-1 IDA 뷰어

왼쪽패널은 Graph탭및 Table탭을포함합니다. Graph탭은모든데이터포인트가머무름
시간을나타내며전구체이온으로선택되었던이온의m/z속도를나타내는가상등고선도를
표시합니다. Table탭은가상등고선도에서데이터포인트의표보기를보여줍니다. 오른쪽
패널은선택된데이터포인트의스펙트럼을보여줍니다. 처음에 MS/MS 스펙트럼이나타납니
다.

등고선도는피크강도를반영하기위해컬러강도를사용합니다. 짙은컬러는강도가더센
피크를표시합니다. 가능한경우라벨이표기되어데이터포인트가서로중첩되지않도록합
니다. 등고선도를주밍해영역을보다자세하게검사하고더많은라벨을보여줍니다.

5. 왼쪽패널에서, 이전에브로모크립틴과관련된피크가발견된 4분에서 5분까지, 640 Da에서
700 Da까지의영역을확대/축소합니다.

왼쪽(그림 3-2) 그림은왼쪽패널만보여줍니다. 현재화면이다른경우 Show Options아이
콘을클릭하고Options의General탭대화상자에서Merge spectra with similar precursor
masses체크박스를지웁니다.

많은수의 MS/MS 스펙트럼이이영역에서수집되었고크로마토그래피피크가매우협소함에
도불구하고이런피크는동일한피크에서비롯됩니다. 또한동위원소집단의각피크에대
해 MS/MS 스펙트럼이수집되었습니다.

6. 그래프에보다자세히확대/축소하여 668 Da ~ 672 Da m/z의속도로피크클러스터에집중합
니다. 그림 3-2의오른쪽패널을참조하십시오.
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그림 3-2 IDA 뷰어

7. 669.2197 피크의처음을선택(위의오른쪽패널에별표로표시)한후 Displays an XIC for
selection아이콘을클릭하면조사스캔에서전구체질량에대한 XIC를보여줍니다.

초기에피크를선택함으로써해당 MS/MS 스펙트럼이나타나게됩니다.
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그림 3-3 조사스캔에서전구체질량에대한 XIC

등고선도에서라벨이붙지않은데이터포인트가있는경우생성이온스캔시간이조사크로
마토그램과관련되도록커서를옮겨m/z속도및머무름시간라벨을표시하도록합니다.

669.2 피크에서, 처음세개의스캔은 4.21분의첫번째 XIC 피크와관련된것이고, 여기서 668.2
스캔도생성되었습니다. 이후두개의스캔은 4.27분의피크와관련된것이고, 마지막스캔은
4.42분의피크(669.2177/4.46)와관련된것입니다. 4.52분의 669.2 피크에는스캔이수행되지않
았지만 670.2 피크에는스캔이확보되었습니다.

참고: 비록동일한조사스캔에서검출되었더라도순서에따라확보되었기때문에스캔시
간은약간다릅니다. 작은동위원소피크는큰동위원소만큼빨리검출되지않을수있습
니다.

8. 처음다섯번의 669.2 스캔주위에선택직사각형을그리고오른쪽버튼을클릭한후 Select
Points in Graph Selection을선택합니다.

이를통해스펙트럼창이모든 MS/MS 스펙트럼을겹치게할수있습니다.

시스템이필요한것보다더많은스캔을확보했습니다. 너무가까이에있어다른화합물이될
수없는화합물의처리및융합을위해스펙트럼의숫자를줄임으로써고품질의결과를확보
할수있습니다. 이런스캔측정을위해융합시질량및머무름시간모두를사용합니다.
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9. Show Options아이콘을클릭하고Merge spectra with similar precursor masses를선택
한후Mass tolerance를 10 ppm으로 RT gap tolerance를 0.03분으로설정합니다. (이분석
내피크는대략 2초간격입니다).

10. OK를클릭합니다.

참고: 이대화상자부분을통해사용자는 XIC가추출되는방법또한정의할수있습니다. 질
량폭은기기의분해능또는피크폭과일치해야하며이는처리를가속화하기때문에사용
된시간범위를제한하는것이유용합니다.

이러한방법으로데이터를병합하면 4.21분, 4.28분 4.46분에세개의 669.2 피크가생성됩니다.
IDA 보기창하단의상태표시줄은데이터융합과정을보여주고융합이완료된후에종속스
펙트럼의총수를보여줍니다.

11. 670.2149/4.26에서데이터포인트를클릭한후 Ctrl키를누르고 668.2162/4.27에서포인트를클
릭합니다.

12. MS/MS 스펙트럼창에서 Expands active pane to fill window아이콘, Use percent y-axis
아이콘및 Label all overlaid traces아이콘을클릭한후 x축에확대/축소해 340 ~ 680의영역
을나타낼수있도록합니다.

그림 3-4 스펙트럼: 340 ~ 680 m/z의영역에확대/축소

두개의전구체가 Br 동위원소에해당하기때문에스펙트럼은 Br 원자를보유하는이온을제
외하고동일해야합니다. Br 원자는두개의 Da로분리되는한쌍의피크로표시됩니다. 이사
례의경우 344.0441, 625.1765 및 637.1712에서단편(668.2 추적)은 Br 원자를보유한반면 340.1925,
367.1796 및 588.2877에서는그러하지못했습니다.
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588.2877 피크에화살표를표시하면 668 피크와 670 피크가 Br 동위원소플러스 1의질량으로
라벨이표시되는것으로봐서 588.2877은 HBr의손실을나타냅니다.

13.스펙트럼에서화살표를제거하고 Expands active pane to fill window아이콘을클릭한후
모든데이터포인트를보려면등고선도를줌아웃합니다.

IDA 데이터필터링
IDA 탐색기에는시각화하거나처리할수있는데이터의양을줄이는데사용가능한많은필터가
포함되어있습니다. 이섹션에서이들에대해설명합니다.

1. 등고선도에서 Expands active pane to fill window아이콘을클릭한후도구모음바로아
래에있는 Filtering Controls옆의아이콘을클릭합니다.

그림 3-5 Filtering IDA Data

이창에는슬라이더와체크박스가여러개표시되며, 각각은표시되는데이터양을조정하기
위해사용할수있는다양한필터링조건에해당됩니다. 머무름시간(시간) 및m/z속도(m/z)
를여기에서또는화면을확대/축소함으로써선택할수있습니다.

나머지필터는다음과같습니다.

• TIC: MS/MS 스펙트럼에서피크강도총합에대한제한을설정합니다. 이것은대개작은잡
음스캔을제거하는데사용됩니다.

• Quality: 1 카운트의등가물보다더큰강도총합에대한일부로잡음이될가능성이거의
없으며이를통해스펙트럼품질을추산할수있습니다.

• Matched Int. (%): Fragment Matching을사용할경우알고있는단편수와중성손실로
표시된강도총합의일부를평가합니다.
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• Similarity: 기준스펙트럼이설정된경우에사용가능합니다. 이기능은기준스펙트럼에
서일반적인단편과중성손실에해당되는강도총합의일부를측정합니다. 기준스펙트럼
사용내용을참조하십시오.

• Mass Defect: 질량의일부분에대한단일범위를설정합니다. 일반적인대사수정(O, O2
등)에서는전구체분자의결손을크게변화시키지못하므로결손에가까운범위를이용하
면가능한대사물질이표시될수있어이기능은대사물질을찾을때유용합니다.

• Defect in Range: 단일질량결손범위와더불어소프트웨어를통해사용자는다른질량
범위에적용되는여러결손을정의할수있습니다. 이런범위가정의된경우이체크박스
를통해사용자는필터의적용여부를결정할수있습니다. Options대화상자의Mass
Defect탭에서범위를설정할수있습니다.

• Isotope pattern: 이체크박스를사용해사용자는 MS 조사데이터에하나이상의동위원
소유형필터를적용할수있습니다. 다시말해, 선택된전구체이온에원하는유형이적용
되어있을때에만해당데이터포인트가표시됩니다. 이런유형은 Options대화상자의
Isotope Pattern탭에서정의됩니다.

각샘플필터에는두개의슬라이더가있어범위를정의할수있습니다. 슬라이더를두번클
릭한후값을직접입력합니다.

2. 슬라이더설정을실험하고 TIC (예를들어, 1e3) 또는 Quality (1)값에대한최저설정에서도
놀라운결과가발생하는지주목합니다. 하단 TIC필터는 2e3으로나머지모든장치는 0으로
설정합니다.

브로모크립틴의질량결손은약 0.22로서단순대사물질이이것또는훨씬큰값을가질가능
성은거의없습니다.

3. Mass Defect필터를 0.18과 0.23으로설정하고나머지피크가 4.5분및 650 Da 가까이에있고
이범위(4.40분)에 652.2211 m/z비율에서생성된하나의데이터포인트만있는지확인합니다.

4. Filtering Controls옆에있는아이콘을클릭함으로써필터링제어장치를숨깁니다.

팁! 표시할필터를변경하려면필터영역에서마우스오른쪽버튼을클릭하고 Filters를선
택한후원하는필터를선택합니다.

기준스펙트럼사용

1. 등고선도내 652.2211/4.40(브로모크립틴자체)에서데이터포인트를클릭한후기준스펙트
럼설정(유사성점수용)아이콘을클릭합니다.

참고: 우선그래프를확대/축소하는것이필요할수있습니다.

2. 기준스펙트럼설정(유사성점수용)아이콘옆의화살을클릭한후기준스펙트럼중첩이선
택되었는지확인하십시오.
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3. 654.2185/4.39에서데이터포인트를클릭합니다.

정의된기준스펙트럼및기준스펙트럼중첩선택을통해표시된어떠한스펙트럼도중첩된
기준스펙트럼을가지고있어쉽게비교할수있도록합니다. 이것은피크의이동여부를결
정하는빠른방법을제공하기때문에대사물질로작업할때유용합니다.

낮은질량의브롬동위원소(기준)에대한전구체이온의 MS/MS 스펙트럼을생성하고여기에
높은질량의동위원소에대한스펙트럼을중첩시켰기때문에이전에 668.2 피크에대해생성
된것과유사한화면이나타납니다. 즉, 두개의 Da가따로떨어져있는피크의존재로브롬을
포함한이온을식별할수있습니다.

4. 활성창을확장해창을채움아이콘을클릭한후등고선도에서 Table Filtering Controls를
클릭합니다.

참고: 필요한경우표(드래그및드롭으로창재배열아이콘) 아래에있는스펙트럼창을이
동해모든칼럼이보이도록합니다.

표는그래픽탐색기와동일한정보를표시하지만추가세부사항을제공합니다. 표는또한필
터링제어장치에응답해두화면이동일한스펙트럼을포함하도록합니다. 열선택을통해
스펙트럼을업데이트할수있도록표가스펙트럼화면에연결되며칼럼헤더를클릭함으로
써열을분류할수있습니다.

기준스펙트럼이정의되는경우두개의추가칼럼이표시됩니다. Delta m/z는기준물질전
구체질량및열과일치하는스펙트럼간차이점을보여줍니다. Similarity는두스펙트럼의
유사성을표시합니다.

5. Delta m/z를클릭해표를분류한후약 15.995(산소질량)씩차이가나는여러피크와히드록
시브로모크롭틴대사물질일가능성이있는 31.990(O2) 피크하나가표에들어있는지확인합
니다.

6. 표에서열을클릭해관련스펙트럼을표시합니다.

참고: 이런스펙트럼은전구체질량이포함된스캔에서두개 Da 이상인것과같이높은유
사값을가지고있으며이는 81브롬을포함한이온으로부터획득되었습니다.

요약
이섹션에서는다음작업에대해논의했습니다.

• 그래픽및표형태의 IDA 탐색기뷰어를사용하여 IDA 파일을검사합니다.

• 이것이필요하다는것을결정한이후에관련스펙트럼을융합합니다.

• TIC 및질량결손필터를사용해표시된스펙트럼수를필터링합니다.

• 비교가능하도록스펙트럼을겹칩니다.

• 기준스펙트럼을정의하고표를사용해가능성있는대사물질을찾습니다.

이런작업은 IDA 데이터를처리하는데있어핵심입니다.
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다음섹션에서는브로모크립틴의 MS/MS 스펙트럼을통해구조도구를사용하는방법을설명합
니다.
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소프트웨어는이온질량을구조(.mol 파일로저장)에연결하고생체내변화에대한잠재적인위
치를검색하는데도움을주는도구를포함하고있습니다.

구조를 MS/MS 스펙트럼으로연결

1. 브로모크립틴의 MS/MS 스펙트럼, 652.2211/4.40을지정합니다. IDA 탐색기로작업을참조하십
시오.

2. 등고선도에서 Hides all other panes아이콘을클릭하여스펙트럼만볼수있도록합니다.

3. File > Open Mol File을클릭합니다.

4. Select Mol File대화상자에서 Bromocriptine.mol파일을선택한후 Open을클릭합니다.
설치데이터파일위치에대한정보는구성을참조하십시오.

스펙트럼아래에구조및도구를보여주는새로운창이열립니다.
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그림 4-1 브로모크립틴구조

5. 구조창에서 Show options dialog를클릭하고 Zoom spectrum (if any) on selection및
Mark selected fragment mass with arrows체크박스를선택했는지확인한후OK를클릭
합니다. 다른매개변수는변동없이그대로있을수있습니다.
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그림 4-2 Structure Options 대화상자

구조창이생성된경우스펙트럼이활성화되었기때문에스펙트럼및구조는자동연결됩니
다. Displays a spectrum for selection아이콘을적절한스펙트럼에드래그함으로써구조를
스펙트럼에수동으로연결합니다.

구조창에서드래그를하면커서를따라선(라쏘)이이동하며사용자가이선으로구조의일
부또는전체를선택하면굵은면이작성됩니다. 연결된스펙트럼이있기때문에확대/축소
및스크롤하여선택된하위구조의질량주변영역을표시합니다.

6. 분자전체둘레에라쏘를그리면 (M – H)–이온에해당하는 652.2177의m/z비율에서피크를
표시하도록보기가변경됩니다.

Mark selected fragment mass with arrows체크박스가선택되었기때문에빨간화살표
를피크위및아래에표기하여이것이선택된영역과일치하는이온의기대질량임을표시합
니다(즉, (M – H)-, 이데이터가네거티브모드이기때문).

참고: 구조창의제목은선택과일치하는요소구조및중성화합물의질량을표시합니다(즉,
653.2213 Da 질량을갖춘 C32H40N5O5Br).

Mark selected fragment mass with arrows가선택된경우구조창에아무것도선택되지
않았을때녹색화살표가 652.2177 피크에표기됩니다. 이것은녹색화살표가현재선택의보
완물을표시하며선택되지않은경우보완물이전체분자이기때문입니다.

7. 브롬원자를제외한전체분자를선택합니다. 그림 4-3내용을참조하십시오.
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그림 4-3 브로모크립틴구조

참고: 브롬원자는일반서체로된단하나이며구조창의제목은질량이 574.3029 Da인
C32H40N5O5요소를표시합니다. 스펙트럼에서빨간색화살표는선택부분의예상질량(즉,
브롬질량을뺀 (M – H)–분자이온질량)을표시하며양쪽에 1 Da 떨어진곳에화살표가있습
니다. 분열중추가수소원자가증대또는손실되는것은일반적이며소프트웨어는균열된
각결합에대해파란색화살표한쌍을 +1 및 –1로그림으로써이가능성을표시합니다. 이
경우에서하나의결합이균열됨에따라두개의추가화살표만남게됩니다.

스펙트럼의실제피크는이화살표중하나와일치하며, 수소원자즉, HBr의추가손실을표시
하므로이온질량은 (M – H – HBr)–을나타냅니다.

단편으로사용
소프트웨어에는결합을해제함으로써형성된종의질량및수소원자를추가또는제거함으로
써형성된종의질량을생성할수있는단편이온예측변수가포함되어있습니다.
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참고: 이예측은완전히산술이며화학논리가사용되지않고생성되는단편을과대평가하는
경향이있지만유용한단편분석도구입니다.

1. 구조창활성화를사용해 Show > Fragments Pane을클릭합니다.

Fragment Options대화상자의설정에따라진행표시줄을표시할수있습니다. 그림 4-4내
용을참조하십시오.

2. Show options dialog아이콘을클릭하고그림 4-4에서보여지는것과같이매개변수를설
정한후 OK를클릭합니다.

그림 4-4 Fragment Options 대화상자

작고단순한단편세트가생산될수있도록옵션을설정한후관찰된이온을설명하는데있어
필요에따라결합수및유형을증대시킵니다. 결합해제를허용함으로프로그램속도가느려
지고가능성이없는많은단편을생성할수있습니다.

Fragment Options대화상자내대부분의매개변수는참조안내서에설명되어있지만다음
사항을숙지해야합니다.
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• Automatically recalculate on-the-fly체크박스를선택한경우스펙트럼의어떠한변경
사항(다른스펙트럼으로전환, 매개변수조정) 또는선택을통해단편을재계산해야할수
있습니다. 이것은일반적으로원하는행동이지만많은단편을생산하기위해옵션을설정
하는경우분석속도에영향을미칠수있습니다. 이옵션을사용하지않는경우 Fragment
아이콘을클릭합니다.

• Constrain using peak list는소프트웨어가스펙트럼내에서적절한허용오차를가진피
크와일치하는단편만을보여준다는것을의미합니다.

• Require evidence for previous step when breaking bond는하나이상의결합을해제
하는경우에만효과적입니다. 우선프로그램은하나의결합을해제한후결과조각에서결
합해제를고려합니다. 이옵션을선택한경우추가해제작업전의조각에해당하는이온
이반드시있어야합니다.

이러한매개변수를통해화면은그림 4-5와유사해야하지만임계값설정(또는라벨링)을넘
어서는피크만고려되기때문에약간다를수있습니다.

그림 4-5 브로모크립틴구조

참고: 단편탭의피크와일치하는할당된피크(파란색) 및할당되지않은피크(빨간색)를표
시하기위해스펙트럼내피크에색상을입힙니다.

단편창에는두개의탭이포함됩니다.
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• Fragments: 이사례에서, 이러한조건에서는많은수의단편이생성되지않고 Constrain
using peak list체크박스가선택되었기때문에스펙트럼내에서피크와일치하는몇개
의단편만보여주므로목록이짧습니다.

• Peaks: 스펙트럼내에서임계값을넘어서는피크, 피크강도및단편에할당된여부를나
열하는표를표시합니다. 할당된피크의경우질량오류또한보여줍니다.

그림 4-6 Fragments Pane

3. Fragments탭에서 324.1929의m/z속도에해당하는열을선택합니다. 피크는이것이기대질
량이라는것을보여주기위해빨간화살표로표시되고해당하위구조는구조창에서볼드체
로표기됩니다.
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그림 4-7 Fragmentation Dialog

참고: 구조창제목의구조및질량은이제중성화합물의질량이아닌이온의질량을반영
합니다.

4. 다른단편에할당된구조를검사합니다.

이들구조는분자의두개의고리형부분을분리하는중앙아미드결합과모두관련이있으며
가능성또한있어보입니다.

참고: 할당된요소구조는 79Br 및 81Br을포함한분자이온스펙트럼을비교함으로써단편내
에 Br이존재하는지를추론한기준스펙트럼사용에서생성된중첩된스펙트럼과일치합니
다.

5. 전체질량범위를볼수있도록스펙트럼을확대/축소합니다.

다수의피크중두개즉, 분자의두측면에해당하는 324.1970 m/z와 344.0430 m/z가할당되고
파란색으로표시됩니다. 하지만많은피크가여전히할당되지않습니다.

6. Options대화상자를연후Maximum number of bonds to break을 2로변경합니다.
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참고: 이옵션은임계값설정에따라작은피크몇개는할당시키지만보다많은피크(예:
114.0584, 209.1337 및 227.1431 m/z비율)는할당시키지못합니다. 스펙트럼이빨간화살표
와관련하여라벨이붙는경우구조창에서모든선택사항을클릭하여지워절대질량값을
보여주도록합니다.

7. Break ring bonds체크박스를선택한후 OK를클릭합니다.

이제 209.1337 및 227.1431 m/z에서의이온을포함해많은수의이온이추가로일치됩니다.
Fragments창에서새로운질량을선택해하위구조를강조하면이러한현상이분자의고리
형펩티드부분에서의고리분열과관련이있다는것을보여줍니다. 이런이온은이영역에서
대사수정위치를결정하는데있어유용할것으로예상됩니다.

하위구조를스펙트럼으로추가
구조의일부를선택후선택한부분을이용해향후에필요시참조할스펙트럼주석을추가합니
다. 스펙트럼창크기에따라구조창내Options대화상자를사용해복사용Target Bond Length
를조절합니다.

1. Fragment Options대화상자에서 Break ring bonds체크박스를지워단편수를단순화합
니다.

2. 단편창에서더풍부한이온들중하나와일치하는열을선택해해당하위구조를강조합니
다.

3. 구조창내에서클릭합니다.

4. Edit > Copy를클릭합니다.

5. 활성스펙트럼창에서오른쪽버튼을클릭한후 Paste Image를클릭합니다.

이를통해하위구조이미지를스펙트럼창에붙여넣기할수있습니다.

6. 원하는위치로드래그하여이미지를이동시킵니다. 오른쪽버튼을클릭하여 Delete Image
를선택함으로써이미지를완전히삭제할수있습니다.

이미지는스펙트럼, 즉질량강도위치에연결되어있어사용자가스크롤및확대/축소할수
있습니다.

7. 그림 4-8과유사한최종이미지를생성하려면다른단편이온에대해 2 ~ 6단계를반복합니다.
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그림 4-8 하위구조가추가된스펙트럼

8. 하위구조의위치를확인하려면 File > Print > Print Preview Window를클릭합니다.

일치된이온은파란색으로표시되어있기때문에해당구조와쉽게결합됩니다.

9. 이미지를복사한후묘화프로그램에붙여넣기하여선또는다른기능을추가합니다.

관련된 MS/MS 스펙트럼으로작업
일부어플리케이션에서수정된화합물, 예를들어대사물질의스펙트럼과전구체화합물의스
펙트럼및구조를비교하는데유용합니다.

1. IDA 탐색기를사용해등고선도를다시보여줍니다. 668.2176/4.21에서피크를선택한후등고
선도를숨깁니다.

구조및단편창이스펙트럼과연결되어있기때문에이들이업데이트되어새로운스펙트럼
을반영하지만구조는전구체화합물에서확보되는반면스펙트럼은추가산소원자를가진
화합물에서확보되었습니다(질량에서 16 Da 이상). 많은경우여전히일치되는일부분이있어
변화되지않은분자의부분을표시하지만이경우에중요한이온중그어떤것도일치되지
않고빨간색으로표기됩니다.

구조창에는일부간단한그림도구를포함하고있어일치점을발견할수있는경우구조에
대한수정을확인할수있습니다.

2. 구조창의왼쪽측면에는요소기호가있는그리드가포함됩니다. O를클릭한후메인구조를
향해드래그합니다.

원자가구조와가까운경우구조와가깝게드래그하여커서를따르는결합에통합됩니다.
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3. O기호를드래그하여구조(에르고린)의아래부분까지결합을작성한후마우스버튼을놓습
니다(예: 페닐기링에새로운원자를배치). 그림 4-9는프로세스를보여줍니다.

그림 4-9 Structure Pane

스펙트럼이다시업데이트되고두일치점(668.2089에서분자이온과 588.2828에서 HBr의손실
을나타내는이온)이표시됩니다. 이것으로이제전체요소구조는정확하지만다수의단편이
일치하지않는사실로봐서원자가분자의올바른부분에추가되지않았다는것을제시합니
다.

4. OH그룹을클릭해추가한후구조의상단부분에있는피롤리딘환에드래그합니다. 이동한
원자만볼드체로표기된다는것을확인하십시오. 그렇지않으면강조된전체하위구조가이
동하게됩니다.

그림 4-10에서확인할수있는것과같이이를통해 340.1927, 366.1722, 및 367.1797에서의이온
이일치되며해당하위구조는전구체화합물의스펙트럼에서일치되는히드록실이온형태
입니다.
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그림 4-10 브로모크립틴에서비롯된스펙트럼

일치되지않는많은저질량피크는전구체스펙트럼에존재했거나또는알고리즘에서링결
합을해제하도록허용한경우일치했던히드록실동등물이지만 637.1725에는단순한단편화
단계로인한것이며아직일치되지않을가능성이큰고질량이온이있습니다.

5. Fragments탭에서 668.2089에해당하는열을선택하여라벨로표시하고나머지이온도이와
관련하여라벨로표시되도록합니다.

이것은 637.1725의피크는전구체분자에서 31.0364의손실에해당되므로 CH3NH2또는 CH3O이
될수있음을보여줍니다. 전구체분자스펙트럼에서는이이온이관찰되지않았기때문에구
조의고리형펩티드부분에있는메틸기중하나에서발생하는수산화과정에서이이온이생
겼을가능성이높아보입니다.

6. 구조창에서두번클릭해구조를선택해제한후새로운OH그룹을구조오른쪽에있는메틸
기중하나에드래그합니다.

7. Fragment Options대화상자를열고Mass tolerance를 30 ppm으로설정한후OK를클릭합
니다.

637 이온은이제일치가되었고단편창에서이열을선택하는것은이온이메톡시기모이어
티의손실에해당할수있다는것을보여줍니다.
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8. Fragment Options대화상자를열고 Break ring bonds체크박스를선택한후 OK를클릭
합니다.

세개의결합이해제되도록허용되는경우에만(추가산소원자손실이외에전구체분자에필
요한두개의결합) 209에서이온을일치시킬수있지만지금은다수의단편을일치시킬수있
습니다.

참고: 이제 Fragments창에는 637.1905와같은몇가지질량에해당하는여러행이포함됩니
다. 각행은각각의단편에해당됩니다(결합해제가허용된경우는더많은행이생성됩니
다). 단편창의 Peaks탭에는질량정확도, 해제된결합수, 단편이 radical인지여부등을기반
으로최상이라고할수있는일치점만표시됩니다. 이경우에최고의일치는전구체화합물
을위해생성될수있었던단편에해당하지만관찰되지않았으며이에따라단편탭에서확
인할수있는추가옵션은명백하지않은잠재적경로를제안하는데유용할수있습니다.

요약
이섹션에서는다음작업에대해논의했습니다.

• 구조를 .mol 파일에입력한후스펙트럼에연결합니다.

• 구조의일부를선택후해당질량피크의존재여부를확인합니다.

• 단편창을생성한후매개변수를설정하여간단한단편을관찰합니다.

• 일치하는구성, 하위구조및질량피크를나타내기위해 Fragments및 Peaks탭으로작업합
니다.

• 더욱복잡한단편화경로를허용할수있도록 Fragment Options을변경합니다.

• 하위구조를스펙트럼창에추가합니다.

• 구조를변경해대사물질등의관련된분자의단편화를분석합니다.

일반적으로관찰된이온을설명하는데있어필요에따라단순한단편화프로세스및추가단편
화옵션을허용함으로써시작하는것은우수한사례입니다. 이것은이온단편이일반적으로일
련의단계에서세분화된다는사실과일치하며보다단순한단편이여러결합을깨뜨리는일치
된단계에서보다먼저형성된다는사실과일치합니다. 단순한단편이불안정적일수있고즉시
추가로단편화하여관찰이되지않을수있습니다. 또한많은수의단편화단계지원에는많은
처리시간이필요하고완료하는데많은시간이걸립니다.

관련된분자를비교하는경우참조스펙트럼(전구체분자) 및수정된형태를중첩시키는것이도
움이될수있습니다. 이후화면을구조또는단편창에연결하고이는활성창이바뀜에따라업
데이트됩니다. 하지만중첩이있는경우일치된및일치되지않은이온에적용되는컬러링은식
별이어려울수있어프로그램및화면에익숙해질때까지단일스펙트럼으로작업하는것을권
장합니다.
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단일샘플로작업하는것이일반적이지만한번에여러샘플을비교또는시각화함으로써추가
정보를얻을수있는경우가있습니다. 이섹션은우선소프트웨어에서두개의샘플및이후에
는여러샘플에대해사용가능한일부도구를설명합니다.

샘플두개로작업
일반적인작업흐름은변화측정을위해다른조건하에서확보된두개의샘플을비교하는것입
니다. 예를들어의약품투여후두개의다른시간지점을비교합니다. 이작업(T=0시간및 T= 1
시간)의경우쥐간마이크로솜이포함된브로모크립틴혈장투여잠복기에서비롯된데이터를
비교합니다.

시작전열린모든창을닫습니다.

1. File > Open Multiple Samples를클릭한후샘플데이터를포함하는폴더를탐색합니다.

2. Bromocrip_IDA-DBS in plasma_T=0.wiff및 Bromocrip_IDA-DBS in plasma_T=1.wiff파
일을선택한후파일을창의오른쪽측면으로드래그합니다.

3. OK를클릭합니다.

그림 5-1 여러샘플선택
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여러 IDA 파일을통해조사및종속스캔하는경우별도의 TIC를확인할수있는단일 IDA 파일
을여는것과대조적으로모든샘플의경우모든데이터의단일 TIC를확인할수있습니다. 이
경우그림 5-2에서표시된것과같이두개의 TIC가있습니다.

그림 5-2 TIC

4. Select Experiment 대화상자를열려면 Show > Total Ion Chromatogram (TIC)을클릭합니다.

5. Period 1, Experiment 1 - TOF MS (100 - 2000)를선택한후 OK를클릭합니다.

그림 5-3 Process All Overlays 대화상자
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중첩된추적이처리될때마다표시되는 Process All Overlays대화상자를통해사용자는모
든추적을처리할지활성상태의추적만처리할지선택할수있습니다. 후속작업이모든추
적(샘플)에영향을미치기때문에모든추적을처리하는것이유용합니다.

6. All Overlaid를선택합니다.

7. Only show the dialog again if the shift key is down체크박스를선택해이를기본동작
으로선택합니다.

8. OK를클릭합니다.

조사 TIC의중첩을포함하는창이생성됩니다. 크로마토그램은재현성이매우높고대사물질
의피크가강렬해크로마토그램을확대/축소하고비교함으로써(약 6분동안영역을검사) 확
인할수있으나, 일반적으로추가작업이필요합니다. 보다쉽게비교할수있도록화면을생
성하는방법이많이있습니다. 예를들어기본피크크로마토그램이사용됩니다.

참고: File > Open Heat Map TICs from Wiff를클릭한경우중첩된크로마토그램을먼저
확인할필요없이스트립화면을직접생성할수있습니다.

9. 기존 TIC 창을숨긴후 Show > Base Peak Chromatogram (BPC).을클릭합니다.

10. BPC Options대화상자에서필요에따라설정을변경해그림 5-4의값과일치시킨후 OK를
클릭합니다.

그림 5-4 BPC Options 대화상자

기본피크크로마토그램은머무름시간기능으로서각스캔시가장큰피크강도를표시함으
로써구성됩니다. 추가정보를제공하기위해기본피크질량이이대화상자에지정된질량
허용오차보다훨씬큰경우에각추적은일반적인컬러및회색간에전환합니다.
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옵션으로고려되는질량범위를제한할수있으며이를통해예를들어잡음배경피크로인
해야기된인공물을방지할수있으며머무름시간범위를설정하여처리를빠르게할수있
습니다. 브로모크롭틴의질량이대략 652인것을알기때문에단순한대사물질의속도는 500
m/z이하가아님을알수있습니다.

11. Process All Overlays대화상자에서 All Overlaid옵션을선택한후 OK를클릭합니다.

새로운창은기존 TIC보다훨씬비교가간단하고용이한 BPC를보여줍니다.

그림 5-5 BPC

T=0 샘플(파란색)에비해 1시간샘플(분홍색)을감소시키는것으로보이는두개의피크(빨간
색화살표로표시)가있습니다. 이것은브로모크립틴(6.09분) 및이성질체와일치합니다. T=1
샘플에는있지만 T=0에는없는세개의피크(파란색화살표) 또한있습니다. 이는잠재대사
물질입니다.

참고: BPC는매우유용할수있지만가장강렬한이온행동만을반영합니다(선택된질량범
위내에서). 기본피크가결코되지않는질량피크는결코표시할수없으므로샘플간차이
를찾는경우다른도구를사용하십시오.

12. TIC 창을숨깁니다.
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13. 6.09분에 BPC 창을더블클릭합니다.

14. Process All Overlays대화상자에서 All Overlaid를선택한후 OK를클릭합니다.

이것은두개의중첩된스펙트럼을생성합니다.

15.스펙트럼창에서클릭및확대/축소하여 652 m/z의속도에서동위원소집단을표시합니다.
그림 5-6내용을참조하십시오.

스펙트럼창은쉽게비교할수있는두샘플의중첩된스펙트럼을포함하고있습니다. 이사
례에서 T = 1 hr 샘플(분홍색)에서의강도가 T = 0 샘플에서의강도보다약한것이명확합니다.

개요그래프는전체스펙트럼의가시성을유지하면서세부사항을볼수있는방법을제공하
기때문에이와같은고분해능데이터를살펴보는것은매우가치있습니다.

그림 5-6 약 652 m/z의속도에서동위원소집단

16.크로마토그램창에서라인위로커서를옮기면스펙트럼시간을표시합니다(이전더블클릭).

17.커서가양방향화살표로변경되는경우피크를약 5.8분에드래그합니다.
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스펙트럼은확장된질량범위를계속표시하지만이것은잡음및작은피크에지나지않습니
다. 주창에서대형분홍색피크를표시하려면아래검정색화살표에따라개요그래프에있
는분홍색직사각형을드래그합니다. 마우스에서손을떼면화면은다시정상화됩니다.

그림 5-8의경우 Label all overlaid traces아이콘이선택되었습니다.

그림 5-7 BPC 및스펙트럼
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그림 5-8 모든중첩된추적라벨붙이기옵션을갖춘 BPC 및스펙트럼적용

이런피크에는 T=0 샘플이없습니다.

18.진행하기전에모든창을닫습니다.

두개이상샘플로작업
두개이상의샘플중첩을통해창은혼란스러워질수있으며차이로인해올바른샘플과의결합
이더욱어려워질수있습니다. 소프트웨어에는많은샘플의데이터를보여주는데도움을주는
다른도구들이포함됩니다.

실험에사용된데이터세트는여섯개의다른데이터세트의불순물프로필분석에서비롯됩니
다.

1. File > Open Multiple Samples를클릭합니다.

2. DataSet61.wiff ~ DataSet66.wiff파일을선택한후 Selected패널로이동시킵니다.
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그림 5-9 Multiple Samples Selected

3. OK를클릭합니다.

4. Show > Total Ion Chromatogram (TIC)을클릭합니다.

5. Select Experiment대화상자에서 Period 1, Experiment 1을선택합니다.
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그림 5-10 Select Experiment 대화상자

6. OK를클릭합니다.

7. Process All Overlays대화상자에서 All Overlaid를선택한후 OK를클릭합니다. 그래프는
파일내각샘플에대한 TIC 크로마토그램의중첩을표시합니다.
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그림 5-11 Overlaid TICs from Experiment 1 of DataSet61.wiff through DataSet66.wiff

활성추적제목은볼드체로표시됩니다. 이제목의왼쪽에있는아이콘을클릭하면헤더가단
일선으로접혀정보에대한많은공간이제공됩니다.

8. Show > Overlaid Traces as Heat Map을클릭한후결과창에서색상제어를설정해min%
가 0.5가되고max%가 100이되도록합니다.

팁! 오른쪽버튼을클릭한후색상제어가보이지않는경우 Show Appearance Control을
선택합니다.

9. 크로마토그램창내부를클릭한후 Hides all other panes아이콘을클릭합니다.
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그림 5-12 Heat Map Chromatogram

강도에따라 TIC 컬러코드를나타내는단일수평스트립을통해각샘플이보여집니다. 위의
색채조합을통해노란색은데이터확보를하지못하거나강도가모든샘플내가장큰강도
의 0.5% 미만인지점을나타내며파란색은 0.5%인지점을, 빨간색은가장큰강도신호를나
타냅니다.

창에는여섯개에서일곱개의피크(4.5분에서 6.5분사이)가표시되어있으며 6.5분의피크를
제외하고피크의반응이다양하게나타나고있습니다.

피크의순서는샘플이확보된순서와동일하지만이상적이지않을수있습니다. 이예에서는
순서가적합합니다.

10.창에서오른쪽버튼을클릭한후 Show Samples Table을클릭합니다. 초기에히트맵의오른
쪽에샘플표가표시됩니다. Drag and drop to rearrange the panes아이콘을드래그하면
창을히트맵하단으로드래그하여기존창아래에있는표를이동시킬수있습니다.
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그림 5-13 히트맵크로마토그램용샘플목록

표에는각샘플과관련된다양한텍스트필드열이포함됩니다. Display Name열은편집가
능하지만나머지열은읽기전용입니다. 모든열을사용해표를분류하고샘플보기를할수
있습니다.

11. Imp STD 10에서 5.5분주위를선택한후안쪽을두번클릭합니다.

새로운히트맵스펙트럼창이생성되며전체질량범위가 x축에표시됩니다.
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그림 5-14 히트맵스펙트럼

스펙트럼을보면몇개의질량(400 m/z에서 460 m/z사이)으로인해선택된시간영역에서강
도가높아지는것을확인할수있습니다.

12. Imp STD 10 샘플에대해 Mass/Charge Da 401 주위질량을선택한후오른쪽버튼을클릭하여
Show Spectra for Selected Samples를선택합니다.

이것은선택된샘플에대한스펙트럼을생성합니다. 이시점에서의스펙트럼이표시됩니다.
그림 5-15내용을참조하십시오.

13.히트맵 XIC를생성하려면히트맵스펙트럼에서 Mass/Charge Da 401 주위질량을더블클릭합
니다.
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그림 5-15 스펙트럼

요약
이섹션에서다음작업에대해논의합니다.

• 소프트웨어에서사용할수있는여러샘플도구와협력합니다.

• 두개샘플과중첩된크로마토그램및인터랙티브스펙트럼을비교합니다.

• 여러샘플과히트맵화면을비교합니다.
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이섹션은소프트웨어의바이오도구키트메뉴항목에서사용가능한일부옵션을설명합니다.

참고: 이기능에액세스하려면바이오도구키트마이크로앱기능을반드시활성화해야합니
다활성화가완료될때까지사용가능한옵션은펩타이드단편, 수동재구성하이라이트추가
및수동재구성하이라이트제거로제한됩니다. 릴리스노트문서에서바이오도구키트마이
크로앱기능활성화를참조하십시오.

수동시퀀스
이옵션을사용해소화된단백질샘플에서 MS/MS 스펙트럼데이터를수동으로시퀀스합니다.

1. 메인도구모음에서 Open Sample아이콘을클릭합니다.

Select Sample대화상자가열립니다.

2. Sample Data폴더가아직선택되지않은경우 Browse를클릭하여 Sample Data폴더를탐
색합니다.

3. RP_digests.wiff파일을선택한후 OK을클릭합니다.

Open IDA Sample대화상자가열립니다.

그림 6-1 Open IDA Sample 대화상자

4. With the IDA Explorer옵션이선택되었는지확인한후 OK를클릭합니다.
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그림 6-2 RP_digests.wiff에서비롯된스펙트럼

5. Table탭을클릭합니다.

6. Time 12.73에서m/z 471.2398을선택합니다.

7. 스펙트럼창활성화를사용해 Graph > Duplicate Graph를클릭합니다.

선택된전구체(471.2)에대한새로운스펙트럼창이열립니다. IDA 탐색기창및관련스펙트럼
창이삭제될수있습니다.

자습서Explorer
RUO-IDV-05-2906-KO-B82 / 113

바이오도구키트기능으로작업



그림 6-3 머무름시간 12.73에서전구체 471.2398에대한스펙트럼

8. 738.3833로라벨표시된피크를선택합니다.

9. Bio Tool Kit > Manual Sequence를클릭합니다.

Sequence Options대화상자가열립니다.
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그림 6-4 Sequence Options 대화상자

참고: 동위원소무시및전하상태체크에대한체크박스가선택된경우동위원소및올바
르지않은전하상태를갖춘어떠한피크라도후속아미노산을제안하는소프트웨어에의
해무시될수있습니다.

10. OK를클릭합니다.

Create Sequence대화상자가열립니다.
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그림 6-5 Create Sequence 대화상자

참고: 이대화상자를통해사용자는 y 및 b 시리즈이온과파일이수동시퀀스된이후의전
하상태에대해내려진가설을변경할수있고추론을통해데이터에최고의일치를제공하
는지살펴볼수있습니다.

11. Create Sequence (for Peptide Fragments Pane)체크박스가선택되었는지확인합니다.

12. Precursor charge필드에 2를입력합니다.

13. Fragment charge필드내수동시퀀스트리를따르려면선택된피크의전하값을입력합니
다.

14. OK를클릭합니다.

소프트웨어가새로고침되어빨간수직선을갖춘업데이트된스펙트럼창을표시하고스펙
트럼데이터에서확보또는손실된첫번째세트의잠재적인아미노산을표시합니다.

Explorer자습서
85 / 113RUO-IDV-05-2906-KO-B

바이오도구키트기능으로작업



그림 6-6 수동시퀀스된스펙트럼 — 초기가능성

15.추가로시퀀스되도록빨간수직선의캡션을더블클릭합니다.

소프트웨어가새로고침되어스펙트럼데이터에서첫번째세트의아미노산을표시합니다.

16.잠재적인모든아미노산이추천될때까지단계 15를반복합니다.
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그림 6-7 수동시퀀스된스펙트럼

참고: 그림 6-7에서캡션을클릭한순서는 F > G > I/L > E > Y입니다.

팁! 소프트웨어에서하나이상의잠재적인아미노산을추천하며초기에추천된것과다른
브랜치를따르고싶은경우그래프를홈화면으로돌려보내고이절차를반복해아미노산
라벨과일치하는대안을선택합니다.

펩타이드단편과연결된수동시퀀스

1. Bio Tool Kit > Peptide Fragments를클릭합니다.

펩타이드단편창이열리며수동시퀀스된스펙트럼과연결됩니다.
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그림 6-8 수동시퀀스된스펙트럼과연결된펩타이드단편창

참고: 실험데이터와일치하는아미노산은표탭의칼럼에서빨간색볼드체로표시됩니다.
실험데이터와일치하지만다른목표단편전하를가진아미노산은표탭의칼럼에서빨간
색이탤릭체로표시됩니다.

2. List탭을클릭합니다.

3. Show > Mass Calculators를클릭합니다.

4. AA Property탭을클릭합니다.
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그림 6-9 질량계산기 — AA Property Tab

참고: 질량계산기는수동시퀀스된스펙트럼에자동연결됩니다. 스펙트럼에서비롯된아
미노산시퀀스는 AA sequence필드에표시됩니다.

5. 스펙트럼창이활성상태일때 Bio Tool Kit > Set Sequence Creation Parameters를클릭합
니다.

Create Sequence대화상자가열립니다.
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그림 6-10 Create Sequence 대화상자

6. 다음과같이 Create Sequence대화상자를작성합니다.

• Create Sequence (for Peptide Fragments Pane)체크박스가선택되었는지확인합니다.

• Assume b-series옵션을선택합니다.

• Precursor m/z필드에 471.2398을입력합니다.

• Precursor charge필드에 2를입력합니다.

• Fragment charge필드에 1을입력합니다.

7. OK를클릭합니다.

펩타이드단편창및질량계산기창은시퀀스데이터업데이트로새로고침됩니다.

8. Peptide Fragments창에서 Table탭을클릭합니다.
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그림 6-11 새로고침된수동시퀀스된스펙트럼과연결된펩타이드단편창

9. 스펙트럼창이활성상태일때 Bio Tool Kit > Clear Manual Sequencing을클릭합니다.

모든수동시퀀스표시가제거됩니다.

수동재구성하이라이트추가및제거
Add Manual Reconstruct Highlights옵션을사용하면스펙트럼에해당질량의이론적인m/z
위치를나타내는기호를추가할수있습니다. 이기능은스펙트럼에다중대전된구성요소가포
함된경우스펙트럼에서특정피크가동일한구성요소에해당되는지여부를확인할때유용합
니다. Remove Manual Reconstruct Highlights옵션을사용해기호를제거합니다.

팁! 기호를새로운위치로이동하려면기호의세로선을새로운m/z값으로드래그합니다.

팁! 기호를활성화하려면기호의세로선또는해당전하상태라벨을클릭합니다. 활성화된기
호가m/z위치를표시합니다.

1. 메인도구모음에서 Open Sample아이콘을클릭합니다.

Select Sample대화상자가열립니다.

2. Sample Data폴더가아직선택되지않은경우 Browse를클릭하여 Sample Data폴더를탐
색합니다.

3. RP_Intact.wiff파일을선택한후 OK을클릭합니다.
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그림 6-12 RP_Intact.wiff 파일에서의 TIC

4. 미오글로빈의경우피크의상단영역(5.91 ~ 6.00분)을사용해평균스펙트럼을생성합니다.
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그림 6-13 평균스펙트럼

5. Spectrum창이활성상태일때 Bio Tool Kit > Add Manual Reconstruct Highlights.를클릭
합니다.

Add Manual Reconstruct Highlights to Graph대화상자가열립니다.

Explorer자습서
93 / 113RUO-IDV-05-2906-KO-B

바이오도구키트기능으로작업



그림 6-14 그래프에수동재구성하이라이트추가

6. Value필드에16950을입력합니다.

7. Charge agent로 H+를선택한후 OK를클릭합니다.

하이라이트를포함하여그래프는새로고침됩니다.

그림 6-15 추가된하이라이트가포함된스펙트럼

8. Bio Tool Kit > Remove Manual Reconstruct Highlights를클릭해기호를제거합니다.

하이라이트가제거되며그래프는새로고침됩니다.
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단백질소화
이옵션을사용해지정된단백질의사용자정의된효소분열로인해발생하는이론적인펩타이
드시퀀스에대한정보를확보합니다.

도구모음

도구모음에있는아이콘을사용해필요에따라보기를조절합니다.

표 6-1 도구모음아이콘

이름(툴팁)아이콘

시퀀스내에서찾아바꾸기

대문자로선택전환

시퀀스찾기

참고: 창아이콘삭제로시작하는이도구모음내최종여섯개아이콘은일반창도구모음에
서설명합니다.

시퀀스내에서찾아바꾸기

이옵션을사용해 Sequence필드에서기존텍스트를찾아새로운텍스트로바꾸십시오.

1. 시퀀스내에서찾아바꾸기아이콘을클릭합니다.

Find and Replace Text대화상자가열립니다.

그림 6-16 Find and Replace Text 대화상자

2. Find필드에서대체될정보를입력합니다.

3. Replace필드에서적절한정보를입력합니다.
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4. OK를클릭합니다.

소프트웨어는기존텍스트를사용자지정된대체텍스트로교체합니다.

대문자로선택전환

이옵션을사용해 Sequence필드에서소문자로입력된텍스트를대문자로전환합니다.

1. 적절한텍스트를선택합니다.

2. 대문자로선택전환아이콘을클릭합니다.

소프트웨어는소문자텍스트를대문자텍스트로대체합니다.

시퀀스찾기

이옵션을사용해 Sequence필드에서텍스트를찾습니다.

1. 시퀀스찾기아이콘을클릭합니다.

Find Text대화상자가열립니다.

그림 6-17 Find Text 대화상자

2. Find필드에서적절한정보를입력합니다.

3. OK를클릭합니다.

소프트웨어는일치하는텍스트를강조합니다.

이론적인단백질소화

1. Bio Tool Kit > Digest Protein.을클릭합니다.

Protein창이열립니다.
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그림 6-18 단백질창 - 단백질및펩타이드탭

2. 제공된필드에서단백질또는펩타이드시퀀스를입력합니다.

참고: 이사용지침프로그램의경우 LSDGEWQQV LNVWGKVEAD IAGHGQEVLI RLFTGHPETL
EKFDKFKHLK TEAEMKASED LKKHGTVVLT ALGGILKKKG HHEAELKPLA QSHATKHKIP IKYLEFISDA IIHVLHSKHP
GDFGADAQGA MTKALELFRN DIAAKYKELG FQG(미오글로빈시퀀스)가사용되었습니다.

3. Enzyme를선택합니다.

참고: 이사용지침프로그램의경우트립신이사용되었습니다.

4. Max. missed cleavages를선택합니다.

참고: 이사용지침프로그램의경우 0이선택되었습니다.

5. Digest를클릭합니다.

소프트웨어는소화된펩타이드및시퀀스에대한이론적정보가포함된표를입력합니다.
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그림 6-19 이론적정보가입력된단백질창

6. Variable Modifications탭을클릭합니다.
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그림 6-20 Protein Pane - Variable Modifications Tab

7. Max. number of simultaneous modifications를선택합니다.

참고: 이사용지침프로그램의경우 3이선택되었습니다.

8. 적절한수정의경우 Use열의체크박스를선택합니다.

팁! 아이콘이체크박스왼쪽에나타나는경우전체아미노산목록또는해당되는목록을선
택할수있습니다.

참고: 이사용지침프로그램의경우 [1Ac]에대해체크박스가선택되었습니다.
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그림 6-21 선택된수정사례

9. Protein & Peptides탭을클릭합니다.

10. Digest를클릭합니다.

표결과는사용자의선택을반영하도록수정됩니다.
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그림 6-22 수정된정보가입력된단백질창

LCMS 펩타이드재구성
LCMS 펩타이드재구성은스펙트럼피크를식별하고식별된스펙트럼피크에서디콘볼루션을
수행합니다. LCMS 펩타이드재구성도구는두가지단계로작업이이루어집니다. 첫째, 피크찾
기 '강화' 알고리즘을통해피크를찾을수있습니다. 둘째, 도구는동위원소시리즈및전하시
리즈를형성하는피크집단을찾으며발견된모든구성요소의중성손실을보고합니다.

1. 메인도구모음에서 Open Sample아이콘을클릭합니다.

Select Sample대화상자가열립니다.

2. Sample Data 폴더가아직선택되지않은경우 Browse를클릭하여 Sample Data폴더를탐색
합니다.

3. RP_digests.wiff파일을선택한후 OK을클릭합니다.

Open IDA Sample대화상자가열립니다.
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그림 6-23 Open IDA Sample 대화상자

4. As a standard TIC옵션이선택되었는지확인한후 OK를클릭합니다.

첫번째추적인 IDA Survey from RP_digests.wiff (sample 1) - Sample001이볼드체로표
시되었는지확인하십시오. 필요한경우이추적을선택합니다.

그림 6-24 IDA Survey from RP_digests.wiff

5. Bio Tool Kit > LCMS Peptide Reconstruct (with peak finding)을클릭합니다.

LCMS Peptide Reconstruct Options대화상자가열립니다.
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그림 6-25 LCMS Peptide Reconstruct Options 대화상자

6. 제공된필드에서다음값을입력합니다.

• Minimum retention time필드에서 9.00분입력

• Maximum retention time체크박스를선택한후필드에서유형 16.00을입력

• Approximate LC peak width필드에서 6.0초입력

참고: 근사피크폭은배경분리중오프셋을측정하는데사용됩니다.

• Minimum intensity in counts필드에서 5카운트입력

• Chemical noise intensity multiplier필드에서 1.5입력

• Mass tolerance필드에서 0.100 Da 입력

• Maximum charge필드에서 5입력

참고: 전하디콘볼루션섹션내질량허용오차를통해재구성된피크가이론적으로소화된
단백질과일치하는지그리고동일한펩타이드에속한다른m/z값이그룹화되는지확인합
니다.

7. OK를클릭합니다.

소프트웨어는머무름시간에따라분리되는펩타이드에대한표를보여줍니다. 다음은나열
된각펩타이드를위해제공되는정보입니다. Index, Ret. Time, Mass, Mass / Charge, Int.
Sum, 및 Num. Peaks.
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그림 6-26 재구성된피크리스트

8. Filtering을확장하여사용가능한필터링옵션을표시합니다.

사용가능한필터링옵션에다음이포함됩니다. Intensity threshold, Min. Num. Peaks, 및
Show matched peaks only.
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그림 6-27 Filtering Options

9. 하나이상의필터를선택하여필요에따라화면을조정합니다.

참고: 이사용지침프로그램에서강도임계값은 2.39e4 및최소숫자로설정되었습니다. Num.
피크는 4로설정되었습니다.

그림 6-28 재구성된피크리스트필터링됨

도구모음
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도구모음에있는아이콘을사용해필요에따라보기를조절합니다.

표 6-2 도구모음아이콘

이름(툴팁)아이콘

스펙트럼및 XIC 표시

IDA MS/MS 스펙트럼표시

참고: 창아이콘삭제로시작하는이도구모음내최종여섯개아이콘은일반창도구모음에
서설명합니다.

스펙트럼및 XIC 표시

스펙트럼및 XIC 표시아이콘을선택한경우다음스펙트럼및 XIC 창이열립니다.

그림 6-29 스펙트럼및 XIC 결과표시

생성된 MS 스펙트럼에있어펩타이드의질량에기여를했던화살표가각피크아래에표시됩니
다. 펩타이드질량에기여를했던각m/z피크에대한 XIC는오른쪽에있는창의중첩으로표시
됩니다.

IDA MS/MS 스펙트럼표시

IDA MS/MS 스펙트럼표시아이콘을선택하는경우다음스펙트럼창이열립니다.
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단백질소화를통한 LCMS 펩타이드재구성

1. Bio Tool Kit > Digest Protein.을클릭합니다.

Protein창이열립니다.

2. Protein창에서 Drag to a protein pane to set its peak list아이콘을 Reconstructed Peak
List창으로드래그합니다.

재구성된피크목록내에이들과일치하는단백질창에서펩타이드시퀀스를표시하며Protein
창이새로고침됩니다. 빨간색의볼드체로표시된 Protein창의단편은 Reconstructed Peak
List창에서정확하게일치를갖춘단편입니다. 빨간색보통글자체로표시된단편은, 해당단
편이 Reconstructed Peak List창의Match컬럼에서괄호안에표시된전하상태를할당받았
을경우 Reconstructed Peak List창에서일치된단편입니다. 검정색글자체로표시된단편은
Reconstructed Peak List창의어떠한단편과도일치하지않습니다.
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그림 6-30 재구성된피크목록과연결된단백질창에관한이론적정보

단백질재구성
이옵션을사용해온전한단백질의평균질량(분자무게)을확보합니다.

1. 메인도구모음에서 Open Sample아이콘을클릭합니다.

Select Sample대화상자가열립니다.

2. Sample Data폴더가아직선택되지않은경우 Browse를클릭하여 Sample Data폴더를탐
색합니다.
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3. RP_Intact.wiff파일을선택한후 OK을클릭합니다.

그림 6-31 RP_Intact.wiff 파일에서의 TIC

4. 5.93분의속도에서피크영역을사용해평균스펙트럼을생성합니다. 그림 6-32내용을참조
하십시오.
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그림 6-32 평균스펙트럼

5. 스펙트럼창이활성상태일때 Bio Tool Kit > Reconstruct Protein을클릭합니다.

Reconstruction Options대화상자가열립니다.

그림 6-33 Reconstruction Options
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6. 다음옵션에대해적절한값을입력합니다.

• Start mass: 15000 Da

• Stop mass: 18000 Da

• Step mass: 1.0 Da

7. 적절한 Input spectrum isotope resolution: Moderate (10000)을선택합니다.

참고: 사극자시스템을통해확보한데이터의경우입력스펙트럼동위원소분해능매개변
수대신피크폭매개변수가표시됩니다.

8. 적절한 Charge agent: H+를선택합니다.

9. OK를클릭합니다.

소프트웨어는해당제목Reconstruction, Input spectrum isotope resolution [user selection]
이붙은별도창에서재구성된단백질스펙트럼을생성합니다.

그림 6-34 Reconstruction Pane
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참고: 사극자시스템을통해확보한데이터의경우창의제목은 Reconstruction, Peak width
[value]입니다.

10.재구성된단백질피크를선택합니다.

선택된스펙트럼에수직수동재구성하이라이트를추가해재구성된단백질을생성합니다.

그림 6-35 수동재구성하이라이트가포함된스펙트럼

요약
이섹션에서다음작업에대해논의합니다.

• 소화된단백질샘플에서 MS/MS 스펙트럼데이터를수동으로시퀀스합니다.

• 펩타이드단편을통해수동으로시퀀스된스펙트럼을연결합니다.

• 주어진질량의이론적인m/z속도배치를스펙트럼에표시하는기호(수동재구성하이라이
트)를추가합니다.
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• 스펙트럼에서기호를제거합니다.

• 지정된단백질의사용자정의된효소분열로인해발생하는이론적인펩타이드시퀀스에대
한정보를확보합니다.

• LCMS 펩타이드재구성을통해스펙트럼피크를식별하고식별된스펙트럼피크에서디콘볼
루션을수행합니다.

• 재구성된피크목록을갖춘단백질창에서이론적인정보를연결합니다.

• 온전한단백질의평균질량(분자무게)을확보합니다.
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